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1 Introduction 

Users not wkhing to read the User's Manual can go direct& to Section 6.2 - HIDMOD3 
QUICK START (Page 625) to run the example shown in Chapter 6. C 

The HYDMOD3 W111dows application has been developed by Maurer Engineering Inc. jointly for 

the D E A 4  project to "Develop and Evaluate Horizontal Well Technologyn and the DEA-67 project to 

"Develop and Evaluate Coiled-Tubing and Slim-Hole Technology." This program, written in Visual 

Basic 3.0, is written for use with IBM compatible computers with Microsoft Windows 3.0 or later 

versions. 

HYDMOD3 is an integrated computer model of comprehensive drilling hydraulics. It covers 

detailed hydraulics, from surge and swab to nozzle selection - almost every aspect of hydraulics. The 
LI window-style program graphically displays the data and allows the user to quickly optimize the hydraulics 

program. Many potential problems and sources of confusion (whether the formation will break down 

- or a kick will occur, what the optimized nozzle area should be) can be clarified. 

- 1.1 FEATURES OF HYDMOD3 

The new or expanded features of HYDMOD3 are its ability to: 

1. Suppoa English, metric and customized systems of units. The customized system of units 
allows the user to select a different unit for different variables ranging from US to SI 

(metric). 

2. Automatically save the unit system information and recall them the next time HYDMOD3 
is run. 

3. Deal with deviated and horizontal wells. 

4. Handle up to five BHA sections, ten drill strings and twenty well intervals. 

5. Offer five calculation options covering different aspects of hydraulics: hydraulics analysis, 
surgehwab, cuttings transport, volumetric displacement, and well planning. 

6. Graphically show flow pattern of turbulent or laminar flow in the wellbore. 

7. Allow correlation between predicted and actual pressure drop by an "effective viscosity." 

8. Show the influence of parameters on hydraulics by sensitivity analysis. 

9. Display ECDs and other hydraulics details at various locations in the well by clicking on 
the wellbore schematic. 

10. Allow input of pore pressures and fracture pressures for different well intervals. 



11. Animate the volumetric displacement of up to ten different fluids each pumped at up to ten 
different rates including shutdown periods. 

12. Plan wellbore hydraulics for specific mud programs. 

13. Support color printers for graphics. 

The output window is a compilation of child windows of text reports and graphs. Each 

calculation option has one to six output child windows depending on the option. These are described in 

Section 5.1.3 "Output Window." 

1.2 REQUIRED INPUT DATA 

There are six data files associated with HYDMOD3: the well data file (. WDI), the survey data 

file (.SDI), the formation data file (.FDI), the tubular data file (.HT3), the parameter data file (.HP3), 

and the project data file (.HY3) containing the paths and filenames of the other five files. 

WDI (Well Data File) : 

1. Well data (company name, project name, well location, etc.) 

SDI (Survey Data File): 

2. SDI - Directional survey data for the well. Survey must start with zero depth, zero 

azimuth, and zero inclination. 

FDI (Formation Data File) 

3. Vertical depth of the bottom of each formation layer with its pore and frac pressure 

gradients. 

HT3 (Tubular Data File): 

4. Casing shoe depth 

5. Surface combination type 

6. Nozzle size or TFA 

7. Lengths, ID, OD, pressure drop of BHAs 

8. Lengths, ID, OD of drill strings 

9. Tool joint OD and length 

HP3 (Parameter Data File): 

10. Calculation options 

11. Rheology model, mud weight 

12. Pump stroke rate and stroke displacement 

13. Pipe running speed (for surge and swab analysis) 

14. Cuttings size and density (for cuttings transport) 



All input data saved on the disk or in the memory are in the English system of units. 

The data sharing information for each analysis option is listed below in Table 1-1. 

TABLE 1-1. Analysis Options and Required Data 

1.3 DISCLAIMER 

No warranty or representation is expressed or implied with respect to these programs or 

documentation, including their quality, performance, merchantabiity, or fitness for a particular purpose. 

1.4 COPYRIGHT 

Participants in DEA-44/67 can provide data output from this copyrighted program to third 

parties and can duplicate the program and manual for their in-house use, but cannot give copies of the 

program or manual to third parties. 
rh 





2. Theory 

I 

2.1 HYDRAULICS ANALYSIS 

- The models most commonly used in the drilling industry to describe fluid behavior are the Bingham 

plastic and power-law models. They can be used to calculate frictional pressure drop, swab and surge 

pressures, etc. HYDMOD3 is based on equations derived in Applied Drilling Engineering (Bourgoyne et al., 

1986) and API SPEC 10. The more sophisticated Herschel-Buckley model has not been included in this 
program because of lack of experimental data, but it will be considered for future versions. 

2.1.1 

The Bingham plastic model is defined by Eq. 2-1 and is illustrated in Figure 2-1. 

where: 

ry = Yield stress 

pp = Fluid viscosity 
z = Shear stress 

= Shear rate 

2 

SHEAR RATE, y 

Figure 2-1. Shear Stress Vs. Shear Rate for a Bingham Plastic Fluid 
(Bourgoyne et al., 1986) 



As shown in Figure 2-1, a threshold shear stress known as the yield point (sy) must be 

exceeded before mud movement is initiated. 

The mud properties pp and T,, are calculated from 3 W  and 600-rpm readings of the 

viscometer as follows: 

where: 

Om, 03* = shear readings at 600 and 300 rpm, respectively. 

Calculation of frictional pressure drop for a pipe or annulus requires knowledge of the 

mud flow regime (laminar or turbulent). 

1. Mean Velocity 

The mean velocities of fluid are calculated by Eq. 2-3 and 24 .  

For pipe flow: 

For annular flow: 

Where: 
- 
v = Mean velocity, Wsec 

Q = Flow rate, gaVmin 

d = Pipe diameter, in. 

d2 = Casing or hole ID, in. 

d, = Drill string OD, in. 

2. Hedstrom Number 

The Hedstrom number, NHE, is a dimensionless parameter used for fluid flow regime 

prediction. 

For pipe flow: 



For annular flow: 

24,700 p T,, (4 - dJ2 
NHE = 

6 
Where: 

p = Mud weight, lblgal 

3. Critical Reynolds Number 

The critical Reynolds number marks the transition from laminar flow to turbulent 

flow. The correlation between Hedstrom number and critical Reynolds number is presented in 

Figure 2-2. The data in Figure 2-2 have been digitized in the program for easy access. 

Figure 2-2. Critical Reynolds Numbers for Bingham Plastic Fluids 
(Bourgoyne et al., 1986) 

4. Reynolds Number 

Reynolds number, NRe, is another common dimensionless fluid flow parameter. 

For pipe flow: 



For annular flow: 

5. Frictional Pressure Drop Calculation 

For pipe flow, the frictional pressure drop is given by: 

(1) Laminar flow (NRe < Critical NR,J 

(2) Turbulent flow (NRe L Critical NR,J 

where f is the friction factor given by 

For annular flow, the frictional pressure drop is: 

(I) Laminar flow (NRe < Critical NR,J 

(2) Turbulent flow (NRe L Critical NRJ 

where f is determined using Eq. 2-1 1.  

2.1.2 Power-& Model 

The power-law model is defined by Eq. 2-14 and illustrated in Figure 2-3. 



- 
where: 

,- 

K = Consistency index, equivalent centipoise (see Bourgoyne et al., 1986) 

n = Flow behavior index, dimensionless 

Figure 2-3. Shear Stress Vs. Shear Rate for a Power-Law Fluid (Bourgoyne et al., 1986) 

The fluid properties n and K are calculated as follows: 

em0 n = 3.32 log- 
e,, 

Occasionally, the consistency index is expressed in units of lbf sn/sq ft. The two units 

of consistency index can be related (at sea level) by 

1 lbf sn/sq ft = 47,900 eq cp. 

The critical Reynolds number must be determined before the frictional pressure drop can 

be calculated. 

1. Mean Velocity 

For pipe flow: 



For annular flow: 

behavior index n. 

- 
v = Q 

2.448(g - d:) 

2. Critical Reynolds Number 

The critical Reynolds number can be read from Figure 2-4 for a given flow 

Figure 2-4. Friction Factors for Power-Law Fluid Model (Bourgoyne et al., 1986) 

The data in Figure 2-4 can be approximated by the following (Leit2o et al., 1990): 

Critical NR, = 4200 

Critical NRe = 5960 - 8800 n 

Critical NRe = 2000 

3. Reynolds Number 

For pipe flow: 

for n < 0.2 

for 0.2 I n s 0.45 

for n > 0.45 



For annular flow: 

N R e  = 

4. Frictional Pressure Drop Calculation 

For pipe flow: 

(1) Laminar flow: (NRe < Critical NJ 

(2) Turbulent flow (NRe r Critical NRJ 

where the frictional factor f is given by: 

For annular flow: 

(1) Laminar flow: (NRe < Critical NRe) 

(2) Turbulent flow (NRe r Critical NRe) 

where f is calculated using Eq. 2-23. 

2.1.3 Bit Pr-e Drw 

Three assumptions are made to calculate the bit pressure drop. They are: 

1.  The change in pressure due to change in elevation is negligible. 

2. Upstream velocity is negligible compared to nozzle velocity. 



3. Frictional pressure drop across the nozzle is negligible. 

Nozzle velocity equals 

where: 

V,, = Nozzle velocity, Wsec 

Q = Flow rate, gallmin 

AT = Total nozzle area, in. 2 

and bit pressure drop equals 

AP, = P Q~ 
12,032 C: 

where: 

Cd = discharge coefficient factor (recommended value = 0.95) (Bourgoyne et al., 1986) 

The hydraulic horsepower (HHP) and the impact force (3) at the bit are 

The total pressure drop in the system equals: 

Pbd = EPp + EPa  + AP, 

Where: 

c Pp = Summation of pressure losses inside the pipe 

c Pa = Summation of pressure losses in the annulus 



Therefore, the pump horsepower (PHP) is 

Q PHP = P,, - 
1714 

2.1.4 1 
Surface equipment consists of the standpipe, hose, swivel washpipe and gooseneck, and the 

kelly. Four common combinations of surface equipment are listed below. 

CASE NO. 1 
40ftof3in. ID Standpipe 
45 ft of 2 in. ID Hose 
4ftof2in.  ID Swivel 
40 ft  of 2 % -in. ID Kelly 

CASE NO. 2 
40 ft of 3%-in. ID Standpipe 
55 ft of 2%-in. ID Hose 
5 ft  of 2%-in. ID Swivel 
40 ft of 3%-in. ID Kelly 

CASE NO. 3 
45 ft of 4 in. ID Standpipe 
55ftof3in. ID Hose 
5 ft of 2%-in. ID Swivel 
40 ft of 3%-in. ID Kelly 

CASE NO. 4 
45 ft of 4 in. ID Standpipe 
55 ft of 3 in. ID Hose 
6 ft of 3 in. ID Swivel 
40 ft of 4 in. ID Kelly 

To estimate the overall pressure drop more closely, the curves of the surface equipment 

pressure losses versus flow rate for various combinations are generated based on a table in the 

Wydraulics Manual" by Security Drill String Systems. Equations are generated to fit the curves. 



The following equations are employed in HYDMOD3 to calculate the surface equipment 

losses. 

Case 1: AP,, = 0.002901 Q1-8 

Case2: AP,,=0.001073Q1.8 

Case3: b p s & =  0 . 0 0 0 6 7 6 ~ ' . ~  

Case 4: AP,, = 0.000473 Q1-8 

where: 

A PSud = surface equipment pressure loss, psi 

Q = flow rate, gal/min 

For coiled-tubing operations, the frictional pressure drop in the surface equipment is 

calculated from the length of the remaining tubing on the reel. Calculation dimensions will be taken from 

those in the topmost section of the drill string (coiled tubing). 

2.1.5 5 

Of particular importance is the equivalent circulating density (ECD) at a given depth. The 

ECD is the density of fluid that will have the same hydrostatic pressure as the circulating pressure i.e., 

ECD = = 0 

0.052 x TVD 
(lb/gd) 

where: 

Po = Pressure at the point, psi 

TVD = True vertical depth at the point, ft 

2.2 SURGE AND SWAB PRESSURES 

Equations 2-9 through 2-13 and 2-21 through 2-25 were presented for frictional pressure drop 

calculation, the first set for Bingham plastic fluid and the second for power law fluid. These models can 

also be applied to determine surge and swab pressure if running speed of the drill pipe is known. Surge 

pressure is the pressure increase caused by lowering pipe into the well. Pressure decrease resulting from 

withdrawing pipe from the well is called swab pressure. 



For closed pipe, the estimated annular velocity is (Moore, 1974): 

where: 

vp = Pipe running speed, ftimin 

v = Average annular fluid velocity, Wmin 

K = Clinging constant (recommended value = 0.45). 

Moore suggested using maximum fluid velocity to take into account acceleration and deceleration 

of the pipe. In general, the maximum fluid velocity equals: 

Surge and swab pressures are calculated by substituting mean velocity in the previously presented 

frictional pressure drop equations with maximum fluid velocity. 

Of particular importance is the equivalent circulating density (ECD) due to surge and swab 

pressures. The calculation of ECD can be performed using Eq. 2-33. 

2.3 SLIP VELOCITY AND CUTTINGS TRANSPORT 

Removal of drilled rock fragments from the annulus is one of the primary functions of the drilling 

mud. The particle slip velocity, which defines the rate at which a cutting of a given diameter and 

specific gravity settles out of the well, is often of concern to the drilling engineer. Unfortunately, 

accurate prediction is difficult because of the complex geometry and boundary conditions. 

Two correlations will be used, although other models exist. It must also be noted that the following 

analysis is valid only for vertical sections of a well. As hole angles begin to increase from vertical, 

cuttings transport efficiency begins to fall. 

2.3.1 Moore Correlation 

Moore proposed a procedure for determining the slip velocity through a mud system. His 

method involves obtaining the apparent Newtonian viscosity as follows: 



where: 

V, = Mean annular velocity 

The particle Reynolds number is computed as follows: 

where: 

p, = Mud weight, lb/gal 

d, = Particle diameter, in. 

VS1 = Slip velocity, ft/min 

In the equation above, the slip velocity VS1 is undetermined and is obtained by the following 

iterations: 

For Reynolds numbers greater than 300, the slip velocity is: 

where: 

p, = Solid density, lb/gal 

For Reynolds numbers of 3 or less, the slip velocity becomes: 

For Reynolds numbers between 3 and 300, the slip velocity approximation is given by: 



- 
2.3.2 Chien Car- - 

Chien's correlation uses a similar computation of an apparent Newtonian viscosity for use 
LI in the particle Reynolds number determination. The apparent viscosity is calculated using 

The particle Reynolds number is calculated using Eq 2-37. 

For Reynolds numbers greater than 100, the slip velocity is: 

For Reynolds numbers less than 100, the slip velocity is: 

As can be seen, both correlations may require several iterations andlor trial and error. 

2.3.3 

Cuttings transport ratio is defined by the following equation: 

For pasitive cutthgs transport ratios, the cuttings will be transported to the surface with more or 

less transport efficiency. For negative cuttings transport ratios, cuttings will become concentrated in the 

annulus. Therefore, this is an excellent measure of the carrying capacity of a particular drilling mud. 

2.4 VOLUMETRIC DISPLACEMENT 

HYDMOD3 calculates drill string and annular volume. The time and strokes to pump mud from 

surface to bit, from bit to surface and one full circulation are computed. The program also tracks the 

fluid interface through the tubing and annulus as one mud displaces another. 



2.4.1 of Volumes 

The equations used in volume calculations are: 

Pipe Volume: 

V, = 0.0407967 dZ7 gallondfi 

Annular Volume: 

V, = 0.0407967 (e - d:), gallon& 

The majority of pumps in use are of duplex (two-cylinder) or triplex (three-cylinder single 

acting) design. They are illustrated in Figure 2-5. 

Discharge Discharge Discharge 

I 
T 
Qr 

Inlrl or Suction Suclion Suction 

(a)  Double-acting (duplex) design. (b) Single-acting (triplex) design. 

Figure 2-5. Schematic of Valve Operation - Triplex and Duplex Pumps 
(Bourgoyne et al., 1986) 

For a duplex pump, the total volume discharged per complete pump cycle is given by: 

where: 

L, = Stroke length, in. 

dl = Liner diameter, in. 



4 = Rod diameter, in. 

E,, = Volumetric efficiency 

For a triplex pump, the total pump displacement per pump cycle is: 

2.5 WELL PLANNING AND NOZZLE SELECTION 

The optimhtion of bit hydraulics increases the penetration rate and improves the cleaning action 

at the hole bottom. There is controversy as to whether maximization of hydraulic horsepower or impact 

force produces the best results. The program utilizes both optimization method. Actually, both theories 

provide almost the same results. If hydraulic horsepower is maximum, the jet impact force will be 90% - of the maximum and vice versa. 

2.5.1 

The pump pressure loss, aPp, is expended by the (1) total frictional pressure loss, the so- 

called parasitic pressure loss, aPd, and (2) the bit pressure loss, ap,,. Then - - 
The parasitic pressure, aPd, can be represented by - 

AP, = C Q m  
I 

(247) 

Where m is the flow exponent, usually taken as 1.75, and C is a constant representing mud 
I properties and wellbore geometry. 

The jet impact force is given by Eq. 2-29. 

Fj = 0.01823 Cd Q d n  = 0.01823 Cd Q d m ,  lbf 

where: 

Cd = Discharge coefficient (0.95) 



Using calculus to determine the flow rate at which the bit impact force is a maximum gives 

AP, = - APp 
m + 2  

2.5.2 

Bit hydraulic horsepower, HHP, is given by Eq. 2-28, 

APbQ - ( A p p - C Q m ) Q  
HHP = - - 

1714 1714 

Using calculus, the above equation can be maximized and resolved into 

AP, = -  APp 
m + l  

Although the value of the flow exponent m is usually assumed as 1.75, it is generally best 

to determine m from two sets of pump pressure data (field data) for two flow rates. 

where: 

Qi = (I= 1,2) pump rates 

aPPi = (I = 1,2) pump pressure drop 

aPbi = (I= 1,2) bit pressure drop 

2.5.4 

The most convenient method for the selection of bit nozzle sizes is the graphical solution 

technique involving the use of log-log paper as shown in Figure 2-6. 



Figure 2-6. Use of Log-Log Plot for Selection of Proper Pump 
Operation and Bit Nozzle Sizes (Bourgoyne et al., 1986) 

The path of optimum hydraulics is constructed by three intervals: 

1. q = h, based on the pump specification 
2. aPd = const., based on the criterion used (bit power or impact force) 
3. q = q -, based on acceptable annular velocity for cuttings transport 

After the graph is constructed, calculate the total frictional pressure loss aPd under a given 

flow rate and draw a line through the point (Q,aPd) with the slope m. The intersection of the line with 

the path of optimum hydraulics determines the optimum flow rate. Because minimum and maximum 

flow rates exist, the optimum may not be between the minimum and maximum flow rates. The planned 

flow rate is therefore the closest flow rate to the optimum within the maximum and minimum limits. 

2.5.5 Well Planning 

It is sometimes desired to estimate the proper pump operating conditions and nozzle sizes 

for hydraulics optimization during the planning phase of the well. The data required for planning include 

mud program, hole geometry, and assumed flow rate. The equations in Section 2.1 are employed to 

calculate the frictional pressure drop at various planning depths. Based on frictional pressure drop, the 

program calculates the optimum hydraulics based on either the maximum jet impact force or maximum 

hydraulic horsepower criterion. 

The results of hydraulics optimization indicate only the optimized total nozzle area. Since 

the jet bit may have two, three, or more nozzles, a large number of nozzle size combinations will result 

fC 
that will approximate the optimized total nozzle area closely. The program calculates several potential 

combinations of nozzle diameters for two, three, four, and five nozzle designs. The area variance for 

each combination is also given. 





3. Program Installation 

3.1 BEFOREINSTALLING 

3.1.1 Hardware 

HYDMOD3 is written in Visual Basicm. It runs in either standard or enhanced mode of 

Microsoft Windows 3.0 or higher. The basic requirements are: 

IBM-compatible machine built on the 80286 processor or higher 

Hard disk 

Mouse 

CGA, EGA, VGA, 8514, Hercules, or compatible display (EGA or higher resolution is 
recommended) 

MS-DOS version 3.1 or higher 

Windows version 3.0 or higher in standard or enhanced mode 

A 386 (or higher) IBM compatible PC and Widows 3.1 (or higher) are highly recommended 

for fast performance. 

For assistance with the installation or use of HYDMOD3 contact: 

Gefei Liu or Lee Chu 
Maurer Engineering Inc. 

2916 West T.C. Jester Boulevard 
Houston, Texas 77018-7098 U.S.A. 

Telephone: (713) 683-8227 Fax: (713) 683-6418 
Internet: http://ww.maureng.com 

E-Mail: mei@maureng.com 

3.1.2 

The program disks you receive are two 3 '/z-inch, 1.44 MI3 disks. 



Disk 1 (set up) contains fourteen files, which are listed below. 

HYDMOD3 
HYDTEST 
HYDTEST 
HYDTEST 
HYDTEST 
HYDTEST 
HYDTEST 
LOOKTBL 
SETUP 
SETUP 
s m 1  
SETUPKIT 
VBRUN300 
VER 

EXE 
FDI 
HP3 
HT3 
HY3 
SDI 
WDl 
M R  
EXE 
LST 
EXE 
DL- 
DLL 
DL - 

Disk 2 contains thirteen files. 

CMDIALOG VB_ 
COMMDLG DL- 
GRAPH % 
GRID VB 
GSW EX- 
GSWDLL DL: 
MDICHILD VB_ 
MSAESllO DL- 
MSAJTl10 DL- 
SPIN vB- 
SPREAD20 VB_ 
THREED vB- 
VBDB300 DL - 

We nxommend that all .VBX and .DLL files that have the potential to be used by other DEA- 

44/67 Wdows applications be installed in your Microsoft Windows\SYSTEM subdirectory. This applies to 

all the .VBXs and .D& included here. The HYDMOD3 executable (HYDMOD3.EXE) file should be 

placed in its own dinxbry (default "C:\HYDMOD3") along with the example data fdes "HYDTEST.*". All 
these procedures will be done by a simple set up command explained in Section 3.2. 

In order to run HYDMOD3, the user must install all the files into the appropriate directory on 

the hard disk. Please see Section 3.2 to set up HY DMOD3. 



I It is recommended that the original diskettes be kept as a backup, and that working diskettes be - made from them. 

- It is advisable to make several backup copies of the program disks and place them in different 

storage locations. This will minimize the probability of all disks developing operational problems at the same 

time. 

The user can use the COPY or DISKCOPY command in DOS, or the COPY DISKEITE on the 

disk menu in the File Manager in Windows. 

The following procedure will install HYDMOD3 from the floppy drive onto working subdhctories of 

the hard disk (i.e., copy from A: drive onto C: drive subdirectory HYDMOD3 and WINDOWS\SYSTEM). 

1. Start Windows by typing "WIN" < ENTER> at the DOS prompt. 

2. Insert Disk 1. 

3. In the File Manager of Wmdm, choose Run from the File menu. Type =set up and press Enter. 

4. Follow the on-screen instructions. 

5. Before completing the set up pmas, the set up program checks the AUTOEXECBAT file in the 

computer's root directory. If AUT0EXEC.BAT file contains the SHARE command, it will end 

the set up. If not, a message appears on the screen. 

Please add < PATH > SHARE.EXE/L: 500 to 
your AUTOEXEC.BAT 

m 
Any text edit program can be used to add the SHARE command to the AUTOEXEC.BAT file. Without 

loading the SHARE program, the database look-up table will not function. 



This is all the user needs to do to set up HYDMOD3. After set up, there will be a new Program 

Manager Group which contains the HYDMOD3 application, as shown in Figure 3- 1. 

Figure 3-1. DEA Application Group Created by Set Up 

3.3 STARTING HYDMOD3 

3.3.1 1 
To run HYDMOD3 from Group Window, the user simply doubklicks the "HYDMOD3" icon, 

or when the icon is focused, press CENTER > . 

In the Program Manager, choose Run from the File menu. Then type 

C:\HYDMOD3WDMOD30.EXE <ENTER> as shown in Figure 3-2. 

y,.-.--.."."-- 

$ Run 
$ 
5 

Typelhenaneofapagam.fdda.~doumntad 
Wndows w l  Dpen it for you 

- - 

Figure 3-2. Using Command-Line to Start HYDMOD3 



4. Windows Environment 

HYDMOD3 runs in the Microsoft Windows environment. 

For comprehensive information about Windows, see W s e  Guide to Micros@ Windows 3.1 by Kris 

Jamsa (Microsoft Press, 1992). This section presents only a brief description of the Widows environment. 

4.1 ELEMENTS OF A WINDOW 

Let's consider the parts of a typical window. Figure 4-1 shows the INPUT W i o w  (see Section 

5.1.2 for details). 

Figure 4-1. Parts of a Window 

m)mobI0~3  - [wri,W&J a111 
& lrput Bun Ucrtr H 4  +f~l rn m 

Wellbore Hydraulics Model (HYDMOD3.0) 
- 

File Path and file name 
MHMMOD3ViYDTEST.HY3 

1. The Title Bar 

Well Data Input 
Suwey Data lnput 
Formation Data lnput 
Tubular Data lnput 
Parameter Data lnput 
Unit System: 

The title bar serves two functions: one is to display the name of the current window and the 

other is to indicate which window is active. The active window is the one whose title bar is 

in color. (On monochrome monitors, the difference is shown by the intensity of the title bar). 

The user can make a window active by clicking anywhere within its border. 

mDTEST.WD1 
HYDTEST.SDI 
mDTEST.FDI 
HMTEST.HT3 
HYDTEST.HP3 
English 

I a d i h h s T M ' h a R U N r s n u a T l u ~ ' ~ l o M h  ' ''. I 



2. The Control Boxes 

At the left side of the title bar is the control box. It has two functions. First, it can display the 

CONTROL menu, which enables the user to control the window size using the keyboard. 

Second, doubleclicking the control box will end the current program. 

During execution of HYDMOD3, the control boxes are not needed. The program will run 

according to its own flow chart. 

3. Minimize and M a x h h  Boxes 

At the right side of the title bar are the MMIMIZe and MAXIMIZE boxes. The box with the up 

arrow is the MAXIMIZE box The box with the down arrow is the MINIMIZE box. If a window 

has already been maximized, the MAXIMIZE box changes to a RESTORE box with both up and 

down arrows, as shown in Figure 4- 1. 

Clicking on the MNMIZE box will reduce the window to the size of an icon. The window's 
name in the title bar appears below the icon. To restore a window from an icon, double- 
click on the icon. 

Clicking on the MAXIMIZE box will make the window take up the total working area. 

Clicking on the RESTORE box will make the window take up a portion of the total working 
area, which is determined by how the user manually sizes the window. 

The user should avoid clicking those boxes while running HYDMOD3 unless necessary. 

4.2 WINDOW F'UNCTIONS 

In a dialog box of a normal window, the user will usually find one or more of the following 

sections. 

1. Text Boxes 

TEXT boxes display the informatian that the user enters. Sometimes there is text already typed 

in for the user. The user can utilize arrow keys to edit the existing text. Figure 4-2 shows a 

typical text box. 

Figure 4-2. Text Box 



A CHECK box indicates whether a p&ular condition is on or off. When it is on, an X 

appears. When it is off, the box is empty. Figure 4-3 shows a typical check box. 

Figure 4-3. Check Box 

3. Option Buttons 

OPTION buttons are exclusive settings. Selecting an option immediately causes all other 

buttons in the group to be cleared. Figure 44 is a typical option box. 

Figure 4-4. Option Buttons 

4. Command Buttons 

A COMMAND button perform a task when the user chooses it, either by clicking the button or 

pressing a key. The most common command buttons are the OK and Caucel buttons found 

on almost every dialog box. In most cases, there is a button with a thick border+ default 

button which will be executed if you ~ R S S  <ENTER>. F i  4-5 shows a typical command 

button: 

Figure 4-5. Command Buttons 



A LL~T box gives the user a list of options or items from which to choose. If the LIST box is 

too small to show all possible selections, a SCROU box will appear on the right side of the box. 

The user makes a selection from a LW box by clicking on it, or from the keyboard, 

highlightq the desired item with the arrow keys, and then pressing <ENTER > . Figure 4-6 

is a typical list box. 

p>y 1 ~ight Green 

Figure 4-6. List Box 

A DROFDO~VN L~ST box is indicated by a small anow in a box to the right of the option. The 

m n t  setting is shown to the left of the arrow. When the user clicks on the small arrow, it 

drops to list all selections. A typical dropdown list box is shown in Figure 4-7. 

~ e a d  Cement 
spacer 
Chemical Wash 
N ativa Fluid 

Figure 4-7. Drop-Down List Box 

7. Scroll Bars 

SCROLL BARS are graphical tools for quickly navigating through a long line of items. 

There are two types of scroll bars: HORIZONTAL and VERnCAL SCROLL BARS. 



The small box inside the bar is called the SCROLL BOX. The two arrows on the ends of 

the scroll bar are scroll buttons (Figure 4-8). Clicking the scroll buttons or moving the 

SCROLL BOX will change the portion of the information you are viewing. 

Figure 4-8. Scroll Bar 

8. Grids 

GRID displays a series of rows and columns (Figure 4-9). In case of a long list of items 

or a large amount of information, scroll bars will attach to the grid providing easy 

navigation. 

Figure 4-9. Grid 

In the INPUT window, grids are used to let the user input data. Some columns of grids 

only allow numerical input. Typing of an alphabetical character is prohibited by the 

program. The user can edit an entry by typing desired characters or pressing the 

<BACKSPACE > key to delete. In many grids, just like a spreadsheet, the user can 

insert and delete a row. 

On the other side, grids are for presentation only in the OUTPUT window. They do not 

allow editing. 

The grid supports word-wrapped text presentation, resizeable columns and rows, etc. 

Even though the user can manually change the cell's column width or row height, we do 

not recommend this because all grids in HYDMOD3 are carefully designed to fit the 

length of the appropriate data string. 





5. Basic Operation of HYDMOD3 

HYDMOD3 runs in the Windows environment. Windows' graphical user interface (GUI) and 

point-andclick environment give the user the power and flexibility. In this chapter, the basic operation 

and functions of HYDMOD3 are introduced. 

5.1 WINDOWS IN HYDMOD3 

There are four principal types of windows in HYDMOD3: INTRODU~RY,  UNIT SYSTEM, INPUT, 

and OUTPUT. The HYDMOD3 Windows flow diagram is shown in Figure 5-1. 

Introductory Window & 
.C / Survey Data Input 

Main Window / - -  -- 
File Input I Run 1 -- 

Well Data. .. - - Swcy Data... Formation Data Input 
*Exit Famlti0nI)lt. ... 4 1' 

-- -- 

I I P v B n c l c r ~ . .  
Tubular Data Input -- 

1 1  
Output Window Parameter Data Input 

-- 

Figure 5- 1. Flow Diagram of HYDMOD3 



5.1.1 Introducbrv Windox 

Figure 5-2 shows the INTRODUCTORY Window containing information on the program and 

the disclaimer. 

D W 4  1 DEA-67 
R o j e d  to Develop and Evaluate Horizontal Drilling Technology 

and 
Prejed ta Develop and Evaluate SlimHole and CoileckTubing Technology 

By 
Maurer Engineering I n c  

-- -- 

This copyrighted 1996 confidential reporl and computer program 
are for the sole use of Partidpants on the Drilling Engineering 
Association DEA-44 andlor DEA-67 projects and their affillatea. 
and a n  not to be dlsdosed to other parties. D a b  output from 
the program can be disdosed to third parties. Plrticipanto and 
their afi i l iats arc free to makc mpies ol this reporl and pmgram 
for their In-house use only. 

Maurcr Engineering i n c  makes no t w m n t y  or representation 
either expressed or impiied with resped to the pmgram or doat- 
mentation induding their quality. performanec. merchanbbiiity. 
or h e s s  for a parlicular purpose. 

Khiirlmtiartaa km4urrrJ users rhuuld read Ikrncrrdix & d U s u l c  LAanud. 1 

Figure 5-2. Introductory Window 

There are two command buttons, "QK" and 'Egit." Clicking 'Egit" terminates the program. The 

"OKw button is the default command that allows the user to advance to the Project Window by pressing 

< ENTER > or clicking on the button. 

5.1.2 Input Window 

INPUT Windows consist of five windows for data input of different categories. They are: 

Project, Well Data Input, Survey Data Input, Formation Data Input, Tubular Data Input, and Parameter 

Data Input Windows. 



5.1.2.1 Main W i  
Figure 5-3 shows a typical Main Window. 

mmuow - w.i, rrndorl alrl 
m 1- 

Wellbore Hydraulics Model (HYDMOD3.0) 

F I e  Sustem; 

Pa* ~d 610 name 
~ M o o ~ l E s r . H n  
h-ml-EST.WDI 

I M l 5 m ' S U ' h o r R U N l a r o l n U l - L v l o n b l r n s h ~ r r l r v W i a  1 

Figure 5-3. Main Window 

The Main Window consists of three segments: 

1 .  Path and name of each input data file 

2. System of units currently in use 

3. Calculation progress indicator 

5.1.2.2 l Y d Q & & p u t  WindP.wU 
Figure 5-4 shows a typical WELL DATA INPUT window. 

RHYDMDDJ W d  Ikt. 1- W-l a d  
e 
[plmpFl [+lUl'11I+(TIPIq pq 

HYDTEST.WDI 

Company Name: 
Projed Name: 
Well Name: Well #I 
Well Field: Austin 
Well Cily/!3tat~: 
Date: 
Commenls: 

Figure 5-4. WDZ Window 



The user is asked to input text describing company name, project name, well 

location, date, and comments. They are optional and need not be completed. They are not used in the 

calculations or in the filename specifications. 

String lengths must be less than 30 characters. 

Well data files for HYDMOD3 have the extension "WDI." 

5.1.2.3 -put W D  
Figure 5-5 shows a typical SURVEY DATA INPUT window. 

Figure 5-5. SDI Window 

The user can input up to 400 survey data points. 

The measured depth, inclination angle, and azimuth angle each have two unit or 

format options, which are independent of the application system of units (Metric or English) the user 

selects for the application. The default unit for measured depth is 'feet." The default format for 

inclination is 'Decimal," and for the azimuth is 'Angular." Units can be changed any time while editing, 

and will not affect the system units selected in the Main Widow. 

To edit a number in the text box, press - or - key to move the cursor left or right 

within the box. 

To move the cursor to the next box, press <ENTER> or click the next text box. 

The focus will move to the desired box. When the focus is at the azimuth text box, hit <ENTER> to 

bring the focus to the measured depth text box in the next row. If the focus is at the last row and last 

column of the table, pressing <ENTER> will add a new row at the end of the table, and the cursor will 

go to the first text box of this new row. 



- To move the cursor to the upper or lower rows, press the t or 1 key, or press the 

"Page Upn or the "Page Downw key. - 
I To move the cursor to the left or right text box, hold down the < Ctrl > key and 

press - or - key. The user can also use the tab key to position the cursor. 

I To append a new survey point at the bottom of the table, move the cursor to the 

last row of the table and press 1 key to add a new row. 

Clicking the "Insert Linen button inserts a blank row before the current row. 

Clicking the "Delete Line" button deletes the current row. There is a prompt before deleting to avoid 

any accidental action. 

The SDI files used in HYDMOD3 are compatible with any SDI files in other 

DEA software applications developed by MEI. The SDI files have the extension "SDI." 

5.1.2.4 Formation II'lpIt W m  

Figure 5-6 shows a typical Formation Data Input Window. 

Figure 5-6 FDI Widow 



The FDI Window has four entry fields: option to show pore and fracture pressure 

in the output graph, pore and fracture data format, margin setting, and pore/fracture data. 

1. Option to show the pore and fracture in the output graph: 

The user can choose to show or not show the pore and fracture pressures 

together with the annular pressure profile in the output graph. 

2. Pore and Fracture Data Format: 

The pore and fracture data can be input in two formats. One is pressure 

gradient (psi/ft) or &Palm). The other one is pressure (psi) or &Pa). 

3. Margin Setting: 

Margin setting allows the user to specify the safety factors for hydraulics 

planning. 

The annular pressure is normally designed to provide at least an acceptable 

trip margin above the anticipated formation pore pressure. This is to prevent 

the flow of formation fluid into the well (i. e., to prevent a kick). 

Similarily, when possible, a kick margin is subtracted from the true fracture- 

gradient lime to obtain a design fracture-gradient line. 

Commonly used trip and kill margins are 0.5 lbmlgal (=0.026 psilft). 

4. Pore/Fracture Data: 

HYDMOD3 can handle up to 100 pore/fracture changes. But the user must 

provide at least two data points: the information at surface and at any other 

place, usually vertical depth of bottom hole. 

Description - Formation name 

TVD - True vertical depth of the ending point of a particular formation 

zone 

Pore - Pore pressure at the TVD or gradient within that zone. 

Frac - Fracture pressure data, the TVD or gradient within that zone 

After the pore and fracture data are input, the user can click the 'Draw" 

button to view the 'PoreIFrac Data versus VDn graph located at the right 

side of the window. 

The formation data input files for HYDMOD3 have the extension "FDI." 



5.1.2.5 -ut W- 

Figure 5-7 shows a typical Tubular Data Input Window. 

Figure 5-7. TDI Window 

The TDI Widow has six entry fields: BHA Components with Specified Pressure 

Drop, Drill StringsICollars, Wellbore Intervals, Casing Shoe Depth, Rig Type, and Nozzles. 

1. BHA Components with Specified Pressure Drop (from Bit): 

HYDMOD3 can handle up to 5 different BHA components with specified 

pressure drop, such as MWD, motor, etc. 

Description - Name of the BHA component 

Length - BHA component length 

ID - BHA component ID 

OD - BHA component OD 

Press. - Specified pressure drop within the component 

Cum. L. - Cumulative length of BHA components. As the user types 

the length of the BHA component, the cumulative length will be 

updated. The bit depth label shown in the upper center of the window 

reflects any change in the length. 

2. Drill StringsICollars (from BHA): 

HYDMOD3 can handle up to 10 drill strings/collars. It also lets the user 

consider the influence of tool joints on the hydraulics analysis. 



Description - Name of the drill string/collar 

Length - Drill string or drill collar section length 

ID - Drill string or drill collar inner diameter 

OD - Drill string or drill collar outer diameter 

TJ OD - Tool joint outer diameter (needed only if the user selects the 

influence of tool joints on hydraulics). 

TJ Contact - Tool joint contact percentage (needed only if the user 

selects the influence of tool joints on the hydraulics analysis). The 

estimation of tool joint contact percentage can be found in the "Help" 

window wbich is displayed below. The user can click the "Helpw button 

above the drill string table. 

I m M  TJLH a d  DPJL to cderlate the mantaae; :- 

Figure 5-8 Tool Joint Contact Percentage 

?,"'......... ...................................................................................................... , ................... 

Cum. L. - Accumulative length of all BHA components and drill string 

/collar. As the user types the length of drill string/collar, the cumulative 

length will be updated. The bit depth label shown in the upper center of 

the window reflects any length change. 
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3. Wellbore Interval (from surface): 

HYDMOD3 can handle up to 20 wellbore intervals. 

Description - Wellbore section name 

From - Wellbore section starting depth. The first starting depth is 

always 0 (on surface), and each following depth should be greater than 

the previous one. 

ID - Casing inner diameter or open-hole diameter. 

Tod Joint C o n k t  Pacsntap $J 
. . - .  The dimasions af t h e e  are s h w n  

$below: 

Twl  J d  h p t h  - LP + LB - TJLH- [In] 

D a  Pipe Joinl La@h [DPJLH] d Tod Joinl Len#h U U ]  

To o f T J a n ~ d s T J  
QD m d  TJ eontad ner- 



4. Casing Shoe Depth: 

As the name implies, this represents the measured depth of the casing shoe. 

However, it can be used to monitor any zone of interest along the wellbore, 

such as a weak zone, pay zone, etc. 

5. Rig Type: 

There are five choices for rig type. Four of them are conventional rigs. The 

other one is a coiled-tubing rig. 

For conventional rigs, surface equipment consists of the standpipe, hose, 

swivel, and gooseneck. Combinations for four conventional cases are 

displayed (Figure 5-9) when the "help" button below the rig type drop-down 

list box is clicked. 

7----- 2 Rig Type 
5 

CASE YO1 40 ft. of 3 in I-D. Standpipe 
4 5 R d 2 i n  I.D. Hose 
4 f t d 2 i n  I.D. Swivel 
40fLd2-1/4in. I.D.KeUy 

CASE N0.2 40 ft. of 3 in I.D. Standpipe 
55 fL d 2 in I.D. Hose 
5 f t  d 2-b. I.D. Swivel 
40 ft. d 3-1 /4 in. I.D. Kelly 

CASE N0.3 45 ft. of 4 in 1-D. Standpipe 
55 ft. d 3 in I.D. Hose 
5 f t d 2 - 1 1 2 h  I.D.Swival 
40 f t  d 31/4 in I.D. Kelly 

CASE N0.4 45 ft. of 4 m I.D. Standpipe 
55 fL d 3 in I.D. Hose 
6 f t d 3 i n  I.D. Swivel 
40 f t  d 4 in I.D. Kelly 

Figure 5-9. Surface Equipment Help Screen 

For coiled-tubing operations, the user needs to provide the total length of coiled 

tubing. The explanation of the calculation is displayed in a "Helpw window (Figure 5-10). The user can 

open this window by clicking the "Help" button below the rig type dropdown list box. This particular 

"Help" window only opens when the user selects the "Coiled-Tubing" for Rig Type. 



In order to obtain the length of the remaining tubing 
on the reel, please input the total length of coiled 
tubing when out of hole. 

For the coiled-tubing case. the frictional pressure 
in the surface equipment is calculated from the 
remaining tubing on the reel- Calculation dimensions 
will be taken from the topmost section of drill string 
[coiled tubing) in the left 'Drill strings' grid [highest 
index number) 

Figure 5-10. Rig Type - Coiled Tubing 

6. Nozzles: 

There are two options to choose from: 

Nozzle sizes - Up to ten nozzle sizes can be input 

TFA - Total flow area can be specified instead of nozzle sizes 

Tubular data input files for HYDMOD3 have the extension 'HT3." 

5.1.2.6 P a r a m e t e r ~ u t  Wi&w (PDQ 
Figure 5-1 1 shows a typical PARAMETER DATA INPUT window. 

Calculation Options:- 

Figure 5-1 1. Parameter Data Input Window 
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HYDMOD3 offers five calculation options. Each option requires some distinct 

input data while some common parameters are shared by two or more calculation options. 

For special analyses or to save computer memory, the user can select only part 

of the options. Then only data entry fields associated with the selected options will be enabled. Other 

non-related data entry fields will be disabled (i.e., the frame of the data group will be dimmed), and the 

user cannot access those entry fields. The program will only check the associated input for errors. 

If the option "Volumetric Displacement" is selected, the fluid information and 

pumping schedule must be supplied by the user in the frame called "Volumetric Displacement." The user 

may addlremove a fluid by clicking the "Add"/'Deleten button beside the Fluid Description drop-down 

list box. The name of the fluid can be specified in the drop-down list box (20 characters). Remember 

to press <ENTER> to leave the drop-down list box after the name of the fluid is entered. It is very 

important that the user arranges the fluids in the right order; the item at the end of the list is the native 

mud and the remaining fluids are arranged from bottom to top in the order they are pumped. 

When selecting a fluid in the dropdown list box, all other entries in the frame, 

such as fluid color and pumping schedule, pertain to that fluid. The fluid colors are for the use of fluid 

displacement animation. 

There are two Help buttons on this page. One is for pump stroke displacement 

and is placed in the Flow Rate frame. Clicking on this button will display a separate Help window as 

shown in Figure 5- 12. 

Figure 5-12. Pump Information Help Screen 

It will calculate the pump volumetric discharge based on the liner size the user 

inputs. The equations are discussed in Section 2.4.2. 

The other Help button is about the flow exponent (M) used in well planning and 

nozzle selection. It is located at the lower left comer. Pressing this button will display a Help window, 

as shown in Figure 5-13. 



Figure 5-13. Flow Exponent (M) Help Screen 

Two sets of pump pressure data and nozzle sizes are required to compute m. The 

equation used is presented in Section 2.5.3. 

After all data are input, click the Start command from the Bun menu in the Main Window 

to begin the calculation. When the calculation is finished, the program will unload the INPUT Window 

and show the OUTPUT Window. 

Child windows are employed to display text reports, graphs for various calculation options. 

A child window is a window confined to its parent window - the OUTPUT window. Child windows can 

be displayed independently. The user can manipulate them just as nonnal windows: move, resize, close, 

etc. The arrangement commands in the Widow Menu (Cascade, Tile, Arrange Icons) have the same 

functions as those of the Program Manager of Windows itself. 

Each calculation option except 'Cuttings Transport" has four or six child windows. To view 

the output of a particular calculation option, open the 'window" menu and select the desired child 

window. See Section 5.2.2 for details. Only the child windows belonging to one calculation option can 

be displayed simultaneously. 

Child windows in each calculation option are described in the following sections. 

5.1.3.1 

There are six child windows under this category: Report, Pressure, Frictional 

Pressure, ECD, Velocity and Sensitivity. 



1. Report 

Figure 5-14 shows a typical Report Window. 

Figure 5-14. Report Window 

On the left portion of the window is a wellbore schematic with the curve of 

the inclination angle of the wellbore. The flow pattern (turbulent or laminar) 

in the wellbore can be shown optionally as in Figure 5-15 by checking the 

'Draw Flow Pattern" check box. Red represents turbulent flow; blue 

represents laminar flow; and green indicates a section with specified pressure 

drop, such as BHAs. The user may find the wellbore geometry configuration 

not symmetric about its own center line. This is because the screen resolution 

is not high enough to show the fine detail. 



Figure 5-15. Report Window 

To the right of the wellbore schematic, there are three grids displaying 

different hydraulic details. The top grid shows quantities like pump output 

hydraulic horsepower, bit hydraulics horsepower, wellhead pressure, etc. 

Frictional pressure drop, flow pattern, and average fluid velocity in each drill 

string and annular section are displayed in the middle grid. 

Pressure and Equivalent Circulation Density (ECD) at particular locations in 

the wellbore can be illustrated with the bottom grid. What is unique about 

this grid is that it is interactively related to the wellbore schematic. The user 

can select desired points by clicking the mouse button while the mouse is 

within the flow area, inside the drill string or the annulus. Then the true 

vertical depth, pressure, ECD and fluid velocity at that location will be 

displayed in a row of the grid. While the user is moving the mouse over the 

wellbore schematic, the corresponding measured depth is shown in the box 

above the schematic. A positive number means a point inside the drill string, 

and a negative number means a location in the annulus. 

The user can also specify the depth of interest and put the exact MD in the 

text box above the third grid and click the 'Apply" button beside it. 



2. Pressure 

Figure 5-16 is a typical Pressure Window. 

Total Pressure vs Measured Depth H 

-10000J I I 

Pressure (psi) 

Figure 5-16. Pressure Window 

The y-axis is measured depth. The x-axis is reserved for total pressure. If the 

user selects the 'Show porelfracbm pressure" check box on the PDI page of the 

INFWT Window, the pore and fracture pressure curves will also be displayed. 

3. Frictional Pressure 

The frictional pressure drop along the wellbore is shown in Figure 5-17 

Figure 5-17. Frictional Pressure Drop 
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Figure 5-17 does not take the hydrostatic pressure into account. The left 

curve is for frictional pressure drop inside the drill string. Annular frictional 

pressure drop is expressed in the right curve. The discontinuity at the bottom 

of the curve is due to the pressure drop across the bit. 

4. Equivalent Circulating Density (ECD) 

The ECD in the annulus is shown in Figure 5-18. 

Wellbore ECD vs Measured Depth 

Figure 5- 18. ECD in the Annulus 

5. Velocity 

Figure 5-19 shows the velocity profile inside the drill string and annulus. 

Velocity vs Measured Depth 

Figure 5-19. Velocity Profile Inside the Drill String and Annulus 
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6. Sensitivity 

Figure 5-20 shows the hydraulics sensitivity analysis. This is actually an 

independent window, not a child window, but no user input (keyboard or 

mouse) can occur in any other window until this window is unloaded. 

H+auScr S e n f i b  Andy& - X 

Fik 

- E h t i v e  Vircosityatc: 

Wellhead peuure reatkg [fald data 

Cunent Data Effective Vdua 

Cdculahdmlihcad us.=. M M Q L I I  
Cdarbted wdhd srr. ui dfattirs dele 

Figure 5-20. Hydraulics Sensitivity Analysis 

This window allows correlation between predicted and actual pressure drops 

by 'effectivew plastic viscosity and yield point or n and k depending on the 

rheology model. 

For the sensitivity analysis, five variables can be monitored. They are 

wellhead pressure, casing-shoe pressure, bottom-hole pressure, casing-shoe 

ECD and bottom-hole ECD. Four variables - flow rate, mud weight, PV 

(or n), and YP (or K) - can be varied to see how they affect the above- 

mentioned parameters. 

The range of variables to be varied is specified in the 'Mi. Valuew and 

'Max. Valuew grid. Clicking the 'Recalculatew button will display the result 

in the grid to its right. The results can be presented graphically by pressing 

the 'Graph. . . " button (Figure 5-21). 



Figure 5-21. Graph of Hydraulics Sensitivity Analysis 

Select "Quitw from the File menu to unload the sensitivity analysis window 
and return to the Output Window. 

5.1.3.2 S u r g e a n d  ( C l w  
Six 'child" windows are implemented under this category: Report, Return Flow 

Rate, Casing-Shoe Pressure, Casing-Shoe Equivalent Mud Weight (EMW), Bottom-Hole Pressure, and 

Bottom-Hole EMW. 



1. Report 

Figure 5-22 shows a typical Report Window for surge and swab. 

2 7  8730.0 417.30 7.5llW 1277 34165 1 2 K  

Figure 5-22. Report Window for Surge and Swab 

Note: the Out" in the Swab Analysis is actually the annular fluid drop rate (at 

- the surface) during the swab operation. HYDMOD3 assumes that there is no air column in the annulus 
,- during the swab operation. 

2. Return Flow Rate 
The Return Flow Rate Window is shown in Figure 5-23. It predicts the 

return flow rate as the drill suing is lowered (surge). 

Figure 5-23. Return Flow Rate 
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3. Casing-Shoe Pressure 

Figure 5-24 shows a typical Casing-Shoe Pressure Window. Pressures at the 

casing shoe due to both surge and swab are presented. 

Bit 
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Surge & Swab Effects on Shoe Pressure 
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Figure 5-24. Surge and Swab Effects on Shoe Pressure 

4. Casing-Shoe Equivalent Mud Weight (EMW) 

Casing-Shoe EMW Widow is displayed in Figure 5-25. 

Figure 5-25. Surge and Swab Effects on Shoe EMW 
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5. Bottom-Hole Pressure 
Bottom-hole pressures due to surge and swab are shown in the window as 

follows: 

Figure 5-26. Surge and Swab Effects on Bottom-Hole Pressure 

6. Bottom-Hole EMW 
Figure 5-27 shows the resultant bottom-hole EMW window. 

Figure 5-27. Surge and Swab Effects on Bottom-Hole EMW 
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5.1.3.3 
There is no child window associated with this calculation option. The output 

window will display graphs and tables as follows: 

Figure 5-28. Cuttings Transport 

The user can vary the flow rate locally to see how it influences the slip velocity 

and transport ratio. Any change of flow rate inside the screen will not affect other calculation options. 

To see the slip velocity at various annular location, the user can either input the 

measured depth in the text box or click the mouse button when the mouse pointer is in the annulus of the 

wellbore schematic. 

5.1.3.4 . . 
This category contains four child windows: Report, Volume In, Fluid Fronts, and 

Wellbore Schematic. 



1.  Report 

The Report Window is shown as follows: 

Figure 5-29. Report Window 

2. Volume In 

Figure 5-30 shows the fluid volume pumped in versus time. 

Figure 5-30. Fluid Volume Pumped in Vs. Time 

5-23 

Fluid Volume Pumped In vs Time 
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3. Fluid Fronts 

Up to four fluid fronts can be shown simultaneously in this child window as 
follows: 

HYDYOD3 - [ O W  Wndorl - I F M  Fnnl vt T i r l  

Fluid Front vs Time 

Figure 5-3 1. Fluid Fronts Vs. Time 

For this version, only the fronts of the second, third, fourth, and fifth fluid 

are shown. 



4. Wellbore Schematic 

Figure 5-32 shows the Wellbore Schematic Window. 

Figure 5-32. Wellbore Schematic Window 

An animation of fluid displacement enables the user to visualize the displacement 

process on the screen. The user can monitor up to ten types of data (including elapsed time, strokes, 

fluid in, fluid out, pump rate, fluid volume in, and fluid fronts) displayed simultaneously as the fluids 

flow through the wellbore on the screen. The animation speed can be set from real-time speed to 2 0  

times faster. The user can interrupt the animation by pressing the 'Pause" or 'Terminate" command 

buttons. If the "Pause" is pressed, the animation can be resumed by pressing 'OK." 

5.1.3.5 Well Planning 

Four child windows belong to this category: Report, Optimum Flow Rate, 

Optimum Nozzle Area, and Optimum Pressure. 

1. Report 

Figure 5-33 is a report child window for nozzle selection as well as well 

planning. 



Figure 5-33. Report Window 

There are three grids in this child window. The top grid shows the optimum 

and planned flow rates, nozzle area, etc., for different measured depths of the 

mud program. The middle grid displays several potential combinations of 

nozzle diameters for 2, 3, 4, and 5 nozzle designs. The area variance for 

each combination is also given. Note that all of these combinations are for 

a particular nozzle area shown in the text input box just above the grid. To 

the left of the text box is a dropdown list box containing the optimum nozzle 

areas from the top grid. Clicking any item in the list box will update the 

contents of the middle grid. 

If the user does not have any of the combinations of nozzle sizes listed in the 

grid, the specially designed 'trial and errof grid (bottom of the screen) can 

be used to input additional combination of nozzle diameters for up to five 

nozzles. Total nozzle area and area variance for the user-input combination 

will be displayed in the right two cells if the user presses <ENTER> after 

editing the nozzle diameters in any of the left five cells. 



2. Optimum Flow Rate 

Figure 5-34 shows a typical Optimum Flow Rate Window. 

Figure 5-34. Optimum Flow Rate Window 

The y-axis is the measured depth in the mud program. 

3. Optimum Nozzle Area 
Figure 5-35 shows a typical Optimum Nozzle Area Window. 

Figure 5-35. Optimum Nozzle Area Window 



4. Optimum Pressure 

Figure 5-36 shows a typical Optimum Pressure Window. 

Max. Jct Impact Forcc 

Figure 5-36. Optimum Pressure Window 

There are two lines in this child window. One is the system pressure drop; the other 

is bit pressure drop. Since the pump pmsure is expended by the system pressure loss 

(to and from bit) and bit pressure I=, the summation of two pressure losses at any 

depth should equal the maximum pump pressure. 

5.1.4 m o k  UD Table - D- 

Visual Basic V. 3 provides a function to communicate with database tables created by MS 

ACCESS V. 1.1 and some other database software packages. Inside the HYDMOD3 program disk, there 

is a database file named 'looktbl.mdbw which contains nine tables. These nine tables are: aluminum pipe, 

casing, premium pipe, Class 1, Class 2, Class 3, heavyweight, d d  collar, and tubing. These tables may 

not be complete, but HYDMOD3 lets the user modify each table. HYDMOD3 does not allow the user 

to add a new table. The user can use Microsoft Access V. 1.1 to access this database file to edit or add 

tables. 

If the user clicks the [Look Table] command buttons in HT3, the program opens the disk 

database file with the extension '.mdbU. The default file is 1ooktbl.mdb as shown in Figure 5-37. 



-,- --.-.--.-.-------".--*-...---,-.---**--.*-.*.----* 
]open MDB Fib 
5 

List filer of m: 

Figure 5-37. Open Look-Up Table Database File 

5.1.4.1 Select D d E U x d  

After retrieving the database file, the look-up table screen is displayed on the screen. 

The user needs to select the 'classw (or name) of table by pulling the 'Drop-Down List Tablen on the top 

left comer, which is  shown in Figure 5-38. 

Figure 5-38. Listed Class Tables in Database file 



After the table name is chosen, the user can select the available pipe size. 

Figure 5-39. TDI Look-Up Table with Pipe Size 

All the records with the same pipe OD in the table are then entered into the 

spreadsheet-like table, and the command panel appears on the top right side of the window (Figure 540). 
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Figure 540.  TDT Look-Up Table with Listed Records Command Panel 

Move the mouse and click on the desired record (click on the left-most column to 

highlight the desired record). Click the [Select] command to choose the data record of the selected pipe. 
The program then returns to the input subwindow and prompts with a confirmation box. 



Tubular Data Base 

Insert the data into the grid [Row = 2) ? 

Figure 541. Confirmation Box 

Clicking the [Yes] button will copy the related data field to the input grid. The row 

number of the grid where the data will be copied is determined by the user. Before entering the database 

window, if the user clicks grid row number "n," then the program assumes that row "n" is where the user 

wants the data placed. 

5.1.4.2 

1. [Cancel] command - leaves the look-up database table without selecting data 

record. 

2. [Select] command - selects the focused record from the grid. 

3. [Print Curr. Size] command - prints all the records in the grid table. 

4. [Print Curr. Class] command - prints all the pipe records in the chosen table, 

which contain different size pipe. 

5. [View Detail] command - views one record from the grid table at a time. The 

program will activate the other window, and the user can click [arrow] command 

button to go through all the records shown in the grid table. Figure 542 shows 

the detail window. 



Figure 542. TDI Look-Up Table - Detail Window 

6. [Edit Database] command - edits database record. Clicking this button will 
activate the same window as the [View Detail] command does, but provides 
more edit database command buttons on the bottom of the window as shown in 

Figure 543.  

Figure 543 .  TDI Look-Up Table - Edit Database Command Button 



The following are the operations to modify the database table. 

a. Edit Record: Use [Arrow] command to show the desired record - Change the 

data inside the field text box, - Click [Update] command button to update 

database disk file. 

b. Add New Record: Click [Add] button - Inputs all of the new data fields on text 

boxes, - Click [Update] command button to update database disk file. 

c. Add New Record (which contains most of the same data as the existing record): 

Use [Arrow] button to highlight the desired existing record - Click [Copy] 

command to copy the record to memory - Click [Add] command to create new 

record - Click paste] command to paste the data from memory to screen - To 

edit the necessary data fields - Click Wpdate] command to update database fde. 

d. Delete Record: Use [Arrow] command to select the desired record - Click 

[Delete] command to confirm 'Yesw or 'Now buttons on the prompt window - 
Before using the other command buttons, click [Arrow] command to move to 

another record. 

e. Add New Size Pipe in the Same Table: Click [Add] command to add new 

record - Input the data fields for the new record (with the new pipe OD). Click 

Wpdate] command to update the database field. NOTE: To see the new size 
record, the user haE to leave this editing window, then select the same class 
table again, pull down the pipe OD dropdown list box again, and the new 
size will be shown in the list box. 

5.1.4.3 SHARE DOS Command 
In order to access the database file through HYDMOD3, the user must put the 

SHARE.EXE DOS command into the PC's AUTOEXEC-BAT file (See Section 5.2). Otherwise, the 

following message box will appear on the screen and terminate the program back to the window system. 

Please add < PATH > SHARE.EXEL:SOO to 
your AUTOEXEC.BAT 



5.2 HYDMODS MENUS 

The HYDMOD3 menu system provides many tools that you will use while running the application. 

As in other Windows applications, the user can pull down a menu by clicking the menu name with the 

mouse, or by pressing the ALT Key on the keyboard and then striking the first letter or the underscored 

letter of the menu name. Once a menu is displayed, the user selects a command by clicking the 

command name with the mouse or by highlighting the command name and pressing <ENTER> . 

5.2.1 m u t  FYiudws 

Input windows of HYDMOD3 include five individual windows: One Main Window and five 

data input windows. The menus in these windows are described in this section. 

5.2.1.1 Main W i w  Menus 
There are six menus in this window: 1) F ie ,  2) Input, 3) Run, 4) Qutput, 

5) Utility, and 6) Help, as shown in Figure 5-44. 

IPath and film name 
C:Vm,MOD3WvoTEsr.IiY3 

Well Data Input HYDTEST.WI 
Survey Dala lnput: HYDTEST.SDI 
Forma!ion Data lnput HYDTEST.FD1 
Tubular Data lnput HYDTEST.Hl3 
Parameter Dala lnput HYDTEST.HP3 

Figure 5-44. Main Window Menus 



- 
The Eile menu contains commands for creating, retrieving, saving, and printing 

, project data, as shown in Figure 5-45. 

Figure 5-45. T i e  Menu in the Main Window 

The reason for using the project file is for quick future retrieval of a set of 

previously saved input data. The user can open an existing project file without opening each individual 

(.WDI, .SDI, .FDI, HT3, HP3) file. The project file, which is a collection of the paths and file names 

of all input data files, does the retrieving for the user. 

The seven menu items under the Eile menu are explained below: 

1. 'New Project" command clears all input data and sets all file names to null 

string with corresponding extensions. 

2. 'men Project ..." command opens a dialog box that enables the user to 

explore the file system for input files with the extension 'HY3." See 

Section 5.3.1 for a complete discussion. 

3. "Saye Project" command replaces the previous version of each of the input 

data files in the project with the one modified. Note that the project file 

(.HY3) does not contain any input data. It is simply a list of all the input data 

file names in the project. This list is updated every time the user saves the 

project. 



4. 'Save Project As.. ." command opens a dialog box. The user specifies the 

drive, directory, and the name of the project file. See Section 5.3.3 for 

details. 

5 .  'Print Project Informationw command allows the user to print out the 

information related to the current project, such as path and file name of 

each individual data file. 

6. 'Print All Input Dataw command allows the user to print all input data along 

with the project information. 

7. 'Exitw command terminates the HYDMOD3 program. The program 

prompts the user to save the input files, if they have not been saved. 

Files which make up a project do not have to be in one directory on your hard 

drive, since the project records the detailed path information on each input file. A single file, such as 
an SDI fie, can be part of more than one project. However, if you rename or delete a file outside the 

HYDMOD3 application, and then run HYDMOD3 and try to open the file, HYDMOD3 displays an 

error message warning you that a file is missing. 

The Input menu contains commands for opening and navigating through four 

individual data input windows as displayed in Figure 5 4 6 .  

e u d r  Ddr.. 

Fle SwiUm 

File lPath and file name 
Project CVWDMOD3WfOTEST.HW 
Well Data Input HYDfEST.WDI 
Survey Data lnput HYDTESTSDI 
Formation Data lnput HYDTEST.FDI 
Tubular Data lnput HYDTEST.Hl3 
Parameter Data lnput HYDTEST.HF3 
Unit System: English 

I ~ h h s t d h m R U l l l s n u a T m ~ h r t m b L r n c h h h s b t i o n  1 

Figure 5-46. Input Menu in the Main Window 



1. 'Eel1 Data.. ." command opens the Well Data Input Window. 

2. 'Survey Data.. ." command opens the Survey Data Input Window. 

3. 'Formation Data.. ." command opens the Formation Data Input Window. 

4. 'Tubular Data.. ." command opens the Tubular Data Input Window. 

5. 'Parameter Data.. ." command opens the Parameter Data Input Window. 

The Run menu (Figure 547) contains a command the user selects when ready 

to start calculation. The 'Startw command does just that. The program validates all data before 

calculating. 

m)WD~003 - Wrin WndDl] 2kld 
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Well bore Hydraulics Model (HYDMOD3.O) 

File %= 

File l~ath ond file name 
Project C~MOD3VlYDTEST.HY3 
Well Data Input HYDTEST.WDI 
Sunmy Data lnput HMTE!ST.SDI 
Formation Data laput HYDTEST.FDI 
Tubular Data lnput HYDTEST.Hl3 
Pamrneter Data Input M T E S T . H P 3  
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Figure 547. Run Menu in the Main Window 

The Qutput menu (Figure 5-48) contains a command that allows the user to go 

to the Output Window without calculating, if the calculation has been completed and the input data have 

not been changed. This menu is &led (dimmed) if the input data are modified, or if there are no input data. 
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Wellbore Hydraulics Model (HYDMOD3.0) 

File lPath and file name 
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Well Data Input HYDTEST.WDI 
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Figure 5-48. Qutput Menu in the Main Widow 

The Utility menu contains commands that enable the user to select the system of 

units and monitor type, as shown in Figure 5-49. 
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Wellbore Hydraulics Model (HYDMOD3.0) 

File lPath and file name 
RDjea ~ M O D ~ T E S T . r n 3  
Well Data Input M T E S T . W D I  
Surwy Data lnput HYDTEST-SDI 
Formation Data lnput HMITEST.FDI 
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Unit Syslem: English 
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Figure 5-49. Utility Menu in the Main Window 



1. 'Monochromen command changes all screen colors to black and white. 

Once the screens have been set to monochrome, the program cannot return 

to the color mode unless HYDMOD3 is restarted. 

2. 'Units.. ." command opens the Unit window where the user can select 

'English" or 'metricn or any combination of units. The Units Window is 

shown in Figure 5-50. 

Figure 5-50. Units Window 

Hurit 44x1 

uldts -- 

The Units window includes a units table and several buttons. The units table has 

four columns. The left two columns are units group names, and the third column is a list of combo 

boxes. The combo box can be pulled down to select the unit desired. The right column is the data 

format list. Only the keys '#", ' . " and '0" can be used to change the data format. 

QjC 

If the units selection is not appropriate, three keys at the top of the window can 

be used to change the units system back quickly. Button [Undo All] will abandon all current selections 

and revert to original units, the button [English] or Metric] will set the units system back to default 

English or metric unit systems. Clicking the button [Cancel] not only invokes 'undo alln units section, 

but also closes the Units window and returns to the Main Window. 

A custom units system can be saved by clicking either [Save] or [Save As.. .I. 
.- If [Save As.. .] is selected, a file save dialog box will appear to ask the file path and name. Clicking 

[Save] will save the units system file without any options. 

Wcel Undo All 
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The user can retrieve any custom units system previously saved by clicking the 

button [Other.. .I. A File Open dialog box appears to complete the selection. Each time the user runs 

HYDMOD3, the system of units set in the previous run is automatically loaded. 

The Help menu gives the user information on assistance and the computer system. 

IPath and file name 
m M O D r n T E S T . H Y 3  
HYDl€ST.WDI 

Survey Data Input HMTESTSM 
Fannation Dda lnput mDTEST.FDI 
Tubulor Data lnput mDTEST.HT3 
Parameter Data lnput mDTEST.HP3 

Figure 5-51. Help Menu in the Main Window 

1. 'Assistance.. ." command opens the 'Assistance" dialog box that displays 

MEI's address, phone number, and other applicable information. See 

Section 5.3.6 for details. 

2. 'About.. ." command opens the 'About" dialog box that gives the user instant 

reference information about HYDMOD3 and the current computer system 

information. See Section 5.3.7 for details. 



- 
5.2.1.2 -put W m  - All Data Input Windows (. WDI, .SDI, .FDI, .HT3 .HP3) have only one menu me 

- except in the TDI window. It contains commands for creating, retrieving, saving, and printing the 

corresponding data input file, as shown in Figure 5-52. 

Figure 5-52. Eile Menu in the Individual Data Input Window 

1. 'Nex Filen command clears every entry box in the current data input 

window. 

2. 'Open Filen command opens the dialog box that enables the user to explore 

the file system for input files with the extension names, 'WDI, 'SDI," 

'FDI,", 'HT3," or 'HP3" depending on the current data input window. 

3. 'Save File" command replaces the previous version of the input data file. 

4. 'Save File As..." command enables the user to save a file under a new 

name, specified while also retaining the original file (Section 5.3.4). The 

new file is associated with the project file when you SAVE the project. 

5. 'Print" c o d  allows the user to print the input data of the current input 

window. 

6. "Return" command closes the current data input window and returns to the 

Project Window. HYDMOD3 prompts the user to save the file, if it has 

not been saved. 



In the TDI window, beside the F i e  menu, there is a Eellbore menu. It has one 

command 'Schematic.. . " . Click on 'Schematic.. . " and a wellbore schematic window is displayed, as 

shown in Figure 5-53. 

Figure 5-53. Wellbore Schematic Window 

This window allows the user to check if the tubular and wellbore data input are 

correct. 

5.2.2 -ut W u  

Below the menu bar is the Toolbar. It contains buttons that are shortcuts to some commonly 

used menu items. Clicking a button on the toolbar will cany out the action represented by the icon. 

These commands are equivalent to the corresponding commands in the menu system. Figure 5-54 shows 

the toolbar in the Project Window. 



]path and file name 
~ M O D ~ T E S r . H W  

Well Dab Input HMTEST.WDI 
Survey Data lnput HYDTEST.SDI 
Formation Data lnput 'HYDTEST.FDI 
Tubular Data lnput HMTEST.Hn 
Pammeter Data lnput tiYDTEST.HP3 

Figure 5-54. Toolbar in the Main Widow 

- Same as [New Project] or [New] 

- Same as [Open Project.. .] or [Open File.. .] 

- Same as [Save Project] or [Save] 

- Same as [Print Project.. .] or [Print.. .I 

- Go to previous Widow 

- Go to Main Window 

- Go to WDI Window 

- Go to SDI Window 

Go to FDI Window 

- Go to TDI Window 

- Go to PDI Window 

- GO to next Window 



- Same as [Run] 

• H - Same as [Output] 

Same as [Units.. .] 

- Same as [About ...I 

The logical order to input data is from the Main Window to WDI Window, to SDI Window, 

to FDI Window, to TDI Window, to PDI Window, and back to the Main Window. 

The toolbars in the other data input windows are very similar to those in Figure 5-54. Note 

that when an input window is displayed, such as WDI window, the corresponding button in the toolbar, 

m, will be dimmed and disabled. 

5.2.3 Menus 01@1t WWmy 

The Output Window has four menus: me, J%.ndow, Graph Style, and Help (Figure 5-55). 

I Figure 5-55. Menus in the Output Window 

The EiIe menu contains commands for printing and saving text reports and graphs and 

controlIing application flow (Figure 5-56). 



Figure 5-56. File Menu in the Output Window 

1. "Print RepodGraph" command prints out the text report or graph in the currently active 

child window. The text report prints in the text mode. A high-quality image of the graph 

will be printed at the full resolution of the printer. HYDMOD3 offers the user the option 

of printing in color, as well as on a monochrome printer. With a color printer, the user 

may open the "Graph Stylen menu and select "color" from the "Print Style. " If printing 

in color on a monochrome printer, the printer uses a gray scale instead of color and may 

not produce the desired effect. 

2. "Copy Graph to Clipboard" command copies the graph in the active child window to the 

Widows Clipboard in either a bitmap or metafile format. The format is selected in the 

"Image Format" of the menu "Graph Style." The graph image on clipboard can then be 

pasted to other Windows applications, such as Paintbrush. 

3. "Save Graph to File.. . " command ~ Q ~ I I S  a dialog box (Section 5.3.5). The user specifies 

the drive, directory, and name of the image file. The image of the graph is written to 

disk as a bitmap (.BMP) or metafile (.WMF). The format is selected in the "Image 

Formatn of the menu "Graph Style." 

4. "Return to Main Windown command closes the Output Window and displays the Main 

Window. 

The Kindow menu contains commands that allow the user to select, activate, stack, and tile 
)4 

the report and graph child windows. 



Figure 5-57 shows the pull-down Hindow menu. 

Figure 5-57. Hindow Menu in the Output Window 

1. 'Cascade" command stacks the windows, as shown in Figure 5-58. The program adjusts 
the size of each open window to occupy the same amount of display space. The windows 

are then stacked working from upper-left comer of the Output Window. Only their title 

bars are visible. To place a window in the foreground, click on the window's title bar 

with the mouse. 

Figure 5-58. Cascaded Windows 
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2. "Tile" command tiles all the opened child windows, as shown in Figure 5-59. 

Vehcbg ps Measured 
a 

UDP 
I 

I 

- - 

Figure 5-59. Tiled Windows 

3. "Arrange Icons" command restores the alignment of the report and graph window icons, 
as shown in Figure 5-60. 

Figure 5-60. Arranged Window Icons 



4. '1. Hydraulics Analysis* command opens the sublevel menu used to open or activate the 

six output child windows of Hydraulics Analysis shown in Section 5.1.3.1. Figure 5-61 

displays the indented sub-menu of 'Hydraulics Analysis." 

Figure 5-61. Sub-Level Menus of 'Hydraulics Analysis" 

5. '2. Surge and Swab (Closed Pipe)" command opens the sub-level menu used to view the 

six output child windows shown in Section 5.1.3.2. The indented submenu of 'Surge 

and Swab (Closed Pipe)" is shown as follows: 

Figure 5-62. Sub-Level Menus of 'Surge and Swab (Closed-Pipe)" 
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6. '3. Cuttings Transport" command does not have a sub-level menu. It directly opens the 

screen showing the slip velocity and cuttings transport. See Section 5.1.3.3 for details. 

7. '4. Volumetric Displacementw command opens the sub-level menu which contains four 

items. The corresponding child windows are shown in Section 5.1.3.4. Figure 5-63 

displays the indented submenu of 'Volumetric Displacement." 

Figure 5-63. Sub-Level Menus of 'Volumetric Displacementw 

8. '5. Well Planningw opens the similar sub-level menu. Figure 5-64 displays the indented 

submenu. 

Figure 5-64. Sub-Level Menus of Well Planningw 
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The user is advised to always minimize or close the child windows that are not presently 

needed. This gets them out of the way temporarily and helps the user maintain an orderly display. 

The Graph Option menu contains commands that enable the user to design interactively 

using the following style options. The styles selected in the Graph Option will affect all graphs in child 

windows. 

Figure 5-65 shows the pull-down Graph Option menu. 

Figure 5-65. Graph Option Menu 

1. "Draw Style" command enables the use to choose from "Monochrome" or "Color." 

"Monochrome" will set the background to white, and all other colors to black. 

2. "Border Stylew gives the user the option of using borders. This can only be seen in the 

printout of a graph. 

3. "Grid Style" command enables the user to place grids on the graph axes as desired. 

4. "Line Style" command enables the user to set the width or patterns of the lines drawn. 

5. "Symbols" command enables the user to use default symbols for the graphs. 

6. "Legend Style" command gives the user the option of using a legend (Color or B/W) for 

the graphs. 

7. "Print Style" command enables the user to print the graph in color if the computer is 

equipped with a color printer. 

8. "Image Format" command enables the user to save the graphical image in either bitmap 

or metafile format. 



9. "Default Stylen command sets all above styles to the default values, which are as follows: 

Draw Style: Color 
Border Style: Fixed 
Grid Style: Both 
L i e  Style: Thicker Line 3 
Symbols: None 
Legend Style: Color 
Print Style: Monochrome 
Image Format: Bitmap 

The Help menu is exactly the same as the INPUT Window. 

Figure 5-66 shows the toolbar in the Output Window. 

Figure 5-66. Menus in the Output Window 

The buttons on the toolbar give the user access to several commands in the menu quickly 

and easily. The relationships between the button and menu bar commands are: 

- print RepodGraph] in File menu 

- [Copy Graph to Clipboard.. .] in File menu 

- [Save Graph to File.. .J or [Save Report As.. .] in File menu 

- [Return to Input] in File menu 

- [About] in Help menu 



5.3 HYDMOD3 DIALOG BOXES 

There are five types of dialog boxes associated with menus: File Open dialog box, File Save dialog 

box, Color Dialog box, Assistance dialog box, and About dialog box. 

5.3.1 Pr- 

When the user selects the 'Open Project.. ." command from the File Menu in the INPUT 

Window, the following dialog box will appear (Figure 5-67). 

Figure 5-67. 'Open Project.. . " Dialog Box 

This dialog box enables the user to search the file system for the desired files with extension 

name ".HY3." 

The user can move between sections of the dialog box by simply clicking on the desired 

section. Alternatively, the user can press the <TAB> key from keyboard until the focus moves to the 

desired section. 

There are four list boxes: the drive list box, the directory list box, the file list box, and 

type list box. There is one text box and two command buttons: OK and CANCEL. Their functions are 

described below. 



1. The Drive List Box 

On the lower right comer is the dropdown drive list box. In its normal state, it 

displays the current drive. When the user clicks the arrow at the right of the drive list 

box, it drops to list all valid drives. The user can activate a new drive by single- 

clicking the desired one. 

2. The Directory List Box 
The directory list box displays the hierarchy of paths of the current drive. The current 

directory appears as a shaded open file folder; dimlions above it in the hierarchy appear 
as a nonshaded open file folder, and those immediately beneath the cumnt directory are 

closed file folders. ?he user can change the directory by doubleclicking the selected one. 

Note that in the dkctory list box, a single click only selects (highlights) the item; a double 

click is required for the command to be performed. 

3. The File List Box 
The file list box displays the files in the current directory. The file names shown are 

those specified by their extension name 'HY3." A single mouse click on an item 

makes it appear in the 'File Namen text box. If the user chooses OK at this time, the 

data file is retrieved and all data related to the current calculation mode are displayed 

in appropriate entries. Double-clicking the selected file has the same effect as above. 

When the user selects a new drive, the dinxtory list box is updated, which then causes 

the file list box contents to be updated. When a new directory is selected, the file list 

box is updated, but the drive remains the same. 

The path specification label always represents the current path information. 

4. The Type List Box 

This list box is set by the program. The user cannot change it. It specifies the type 

of files that are to be duplayed in the file list box. In this 'Open Project.." dialog box, 

the type of file is '*.HY3." 

5. 'File Name" Text Box 
The application should also do the following when the user enters text in the 'File 

Namew text box and then presses < ENTER > . 

If a drive letter is entered, the drive, directory, and file list boxes should be 

updated. 

If a directory path is entered (for example, '\HY DMOD3 ") , the directory list 

box and the file list box should be updated accordingly. 

If the name of an existing file (with extension name '.HY3") is entered, the 

dialog will be completed and the files will be retrieved. 



6. Command Buttons 
If the existing file name is shown in the text box, pressing OK will complete the dialog 

and the data file will be retrieved and displayed. 

If the CANCEL button is pressed, the dialog is canceled and no information is made 

available to the application. 

For our example, select 'C:" from drive list box. In the directory list box, frnd 

'HYDMOD3" under "C:\" and double-click it. Then the file list box should be 

updated and the file name 'HYDTEST.HY3" will appear in the file list box providing 

the user set up "HYDMOD3" using the default subdirectory names. Double-click the 

"HYDTEST.HY3" in the file list box to complete the input data file selection. 

When the user selects the 'Open File.. ." command from the File Menu in the INPUT 

Window, the following dialog box will appear (Figure 5-68). 

Figure 5-68. 'Open File.. . " Dialog Box 

This dialog box is almost identical to the "Open Project.. ." box in appearance; however, 

the filter in the type list box is different. Depending on the page from which the search was launched, 

the filter in the type list box will be one of the '. WDI," '. SDI," "FDI," " .HT3" or " .HP3" extensions. 

5.3.3 B v e  Pr- 

When the user selects the "Save Project As.. ." command from the rile menu in the INPUT 

window, the following dialog box appears. 



Figure 5-69. 'Save Project As.. . " Dialog Box 

It looks identical to the "Open Project.. ." dialog; however, it allows the user to specify a 

file to save rather than to open. 

- Note that the filter in the type list box is '.HY3." 

5.3.4 - 
P=- When the user selects the 'Save File As.. ." command from the Eile menu in the INPUT 

window, the following dialog box appears. 

.,.---..-..----.-.--. "----.--...-A--*..w.--.-.T,,..-...... .............. -.-......-.-*- 
jiSavt9 WDI Fib 

I Fib -8: E*c 
i [ ly&d.wdi I c- 

I 

Figure 5-70. 'Save File As.. . " Dialog Box 

This dialog box is almost identical to the "Save Project As.. ." dialog box in appearance; 

however, the filter in the type list box is different. Depending on the page currently being used, the filter 

in the type list box will be one of the ". WDI," '.SDI," "FDI," '.HT3" or ".HP3" extensions. 



5.3.5 'Save Grapb to F I L  * m  

When the user selects the 'Save Graph to File.. ." command from the File Menu in the 

Output Window, the following dialog box will appear (Figure 5-71). 

Savc Inape d the Graph A. xall 
File ~ a r r  - Foldarr 

San, fils a bps: Drix- 

I 3 -  ~cmdas-6 ............................................ I I 
- 

. Figure 5-71. 'Save Graph to File.. " Dialog Box 

Depending on how the image format is set, the filter in the type list box is either '*.BMPW 

(default) or '*. WMF." The difference between bitrnaps and metafiles is that a metafile can be scaled 

proportionally while a bitmap cannot. A metafile is more suitable for copying via the Clipboard to a 

Word document. However, a bitmap can be edited in Paintbrush on a pixel-by-pixel basis. 

5.3.6 'Assistance..." 

When the user selects the 'Assistance.. ." command from the Help menu in both INPUT and 

OUTPUT Windows, the following dialog box will appear (Figure 5-72). 

i For assistance with this program contad: I 
Gefei Uu 

or 
Let Chu 

Maurer Englnterlng I n r  
291 6 West T.C. Jester 

Houston, TX 7701 8 
U.SA 

Phone: 71 3-683-8227 
Fax: 713-683-6418 
Telex 216556 
m a i l :  mei@maureng.com 
Internet http#uww.maureng.com 

Figure 5-72. "Assistance.. ." Dialog Box 



5.3.7 'About..." 

- When the user selects the 'About.. ." command from the Help menu in both INPUT and 

.I 
OUTPUT Windows, the following dialog box will appear (Figure 5-73). 

R o j e d  to Develop and Evaluate Horizontal 
Drilling Technology 

and 
R o j e d  to Develop and Evaluate Slim-Hole and 

Coiled-Tubing Technology 
m 

Maurer Engineering lnc  

CPU : Intel 80486 
Coprocessor : present 
W~ndows Mode : Enhanced Mode 
Wlndous Verslon : 3.95 
Free Memory : 1581 2 KB 

Figure 5-73. 'About.. ." Dialog Box 

LL - 5.4 HYDMOD3 ERROR HANDLING 

When input data on a page are outside the appropriate range of values and the user tries to exit the 

page, HYDMOD3 error checking routines will locate the error. The application will then display an 

error message explaining why the data are not acceptable. The user can ignore the error message and 

leave the page even though the data on the page are in error. This ability enables the user to edit and 

view different input pages without having to complete one before going to another. 

The user can start calculation from any page. If any invalid data are found at this time, the 

application will display an error message and force the user to go to the page with invalid data for 

editing. Figure 5-74 shows some of the error messages. 

,,..,.,.,,+.-...~.~.. *.- ...,.,........ ,.-...- .......,....... - .... .... -v....,.....*.-v.....__._ ...... -....--- V...'..". 

! TDI File 

Figure 5-74. Error Messages 

When an error message appears, click yes or press <ENTER> to return to the associated page in 

the INPUT window. 





6. Example Run of HYDMOD3 

6.1 OVERVIEW 

This chapter presents a complete example run of HYDMOD3. 

The input project file HYDTEST.HY3 will be run to familiarize the user with program operation. 

The user will become familiar with: 

Menu operation. 

Displaying and printing input data. 

Displaying and printing output data. 

6.2 EXAMPLE CASE 

Figure 6-1 (continued on pages 62,6-3, and 6-4) presents a printout of input data for the example 

case. The data shown are from the supplied data files 'HYDTEST.HY3," 'HYDTEST.WD1," 

'HYDTEST.SD1," 'HYDTEST.FD1," 'HYDTEST.HT3 ," and 'HYDTEST.HP3." 

Rydraulics Hodel 

[ ~ r o  ject Information ] 

Project tile: C: \EYDHOD3\HYDTEST. W3 (-) 
Well Data Input file: C: \HYDMOD3\?iYDTEST.WDI (+) 
Survev Data Innut file: C: \EYDMOD3 \HYDTEST. SDI f +I 
Tubulk-~ata~xi~ut file: C: ~EYDXOD~~HYDTEST.HT~ (+j 
Parameter Data Input file: C:\HYDWOD3\EYDTEST.KP3 (+) 

Unit System: English 

Depth : (ft) Flow Rate: (gpm) 
Hole Size: (in) Nozzle Vel: (Sf/.) 
Nozzle Size: (1/32in) Fluid Vel: (it/min) 
m d  weight: (ppg) Pressure: (psi) 
viscosity: (-1 lrorce : 
Yield Point: (lbf/100ft2) 

(lbf) 
Power: (HP) 

K : (Ibf. m'n/ft2) 

Note: (+) = Saved, (-) = Not aved ........................................................... 
End of HYD file 



----- 
Hydraulics Model 

- = - = = = = v = s  

[ Well Data Input ] 

company ~ a m e  : Maurer Engineering Inc. 
Project  Name : DEA-44/67 
W e l l  Name : W e l l  #l 
W e l l  F i e l d  : A u s t i n  
Well city / State : Texas 
Date : 10/10/96 
Comments : Example -- End of WDI Pile --= 

HYDTEST. WDI 

I- 

Hydraulics nodel 

[ Survey Data Input ] 

-~ - - ~- - 

Station Weam. Depth Inclination Azimuth 
( ft) (Dec. ) (Dec. ) ............................................................ 

------ - End of SDI Pile ---- 



-I_______- - 
Hydraulics Model 

==- 

[ Formation Data Input ] 

Trip margin (psi/ft) = 0.1 
Kill margin(psi/ft) = 0.1 

............................................................ 
No. V. Depth Pore Frac 
# (f t) (psi/f t) (psi/f t) ............................................................ 
1 0.0 0.4 0 .7  
2 1000.0  0.4 0.8 
3 2000.0 0.4 0.9 
4 3000.0 0 .4  0 .9  
5 4000.0  0.4 0 .8  
6 5206.3  0 .4  0.85 ............................................................ 

- End of FDI Pile - 



[ Tubular Data Input J 

Bit depth (f t) : 9000.0 
casing shoe depth(ft): 4000.0 
Rig Type: Case No. 1 

Tube Geometry (from bit) .------------.-.--.----- 
No.BHA Sections Length O.D. 

(f t) ( in) 
P. Drop 
(psi) 

-------------------------- - -- 

1 BHA 100.0 4-0 50.0 --------------.----------------------------------------------- 
No.Dril1 Strings Length I.D. 

(f t) ( in) 
O.D. 
( in) -----------------.--.------------.--.------------------------- 

1 Drill Collar 500.0 2.75 7.5 
2 Drill String 8400.0 3.83 5.0 

Well Geometry (from surface) 

---------------------------------.---------------------------- 
No. Components From I.D. 

(ft) ( in) -----------------------------------.-------------------------- 
1 Casing 0.0 11.0 
2 4000.0 11.2 
3 Shale 4950.0 12.5 
4 5000.0 11.2 
5 Depleted Int. 5150.0 11.0 
6 5650.0 11.3 
7 Water Zone 6400.0 11.0 
8 6600.0 11.3 
9 Shale Cap 7150.0 13.0 
10 Major Pay Int. 7250.0 11.3 
11 7800.0 11-3 
12 8500.0 11.35 .............................................................. 

Nozzle Diameters (1/32in) ------------------------- 
12.0 12.0 12.0 12.0 12.0 

TFA (in2) 0.55 

--------- ----------- End of TDI File .-----------e-- 



F Hydraulics Xodel 
--II - 

[ Parameter Data Input ] 

Selected Options: Hydraulics Analysis 
Surge and Swab 
Cutting Transport 
Volumetric Dioplacement 
Well Planning and Nozzle Selection 

Mud Properties: Mud Weight (ppg) : 
Plastic Viscooity(cp): 
Yield Point(lbf/lOOft2): 

Pump Properties: Stroke Rate (stk/min) : 84 
Stroke Displacement(gal/stk): 5.0 

Surge/swab Condition: Pipa Running Speod(ft/min): 100.0 

Cutting Properties: Cutting Diameter (in) : 
Cutting Density (ppg) : 

Volumetric Displacement Schedule: 

............................................................. 
Fluid Pumped Pump Rate Elapsed Time Volume 

(-1 (dn) (bbl) ............................................................. 
spacer 210.0 16.0 80.0 

0.0 10.0 0.0 
Lead Cement 340.0 21.0 170.0 
Tail Cement 140.0 35.0 116.67 

0.0 5.0 0.0 
Polymer 420.0 15.0 150.0 

252 0 5.0 30.0 
420.0 5.0 50.0 
150.0 3.0 10.71 
84.0 4.0 8.0 ............................................................. 

Well Planning: Maxi. pump preeeure(psi): 3423.0 
Maxi. pump horeepover(HP): 1600.0 
Pump efficiency: .9 
Flov rate index: 1.75 
Minimum flow rate (gpm) : 395.0 
The flow rate (gpnt) : 500.0 

Mud Prograr ....................................................................... 
Bit Depth Mud WT PV YP N I K I 
(f t) (PPQ) (CP) ( # I  (-1 ( @ I  ....................................................................... 
5000.0 9.5 15.0 5.0 
6000.0 9.5 15.0 5.0 
7000.0 9.5 15.0 5.0 
8000.0 12.0 25.0 9.0 
9000.0 13.0 30.0 12.0 -----------------------------------------.----------------------------- 
Note: (#) = (lbf/lOOftZ) , (@) = (lbf .s'n/ft2) -------------------------------.-.------------------------------------- 

of PDI Film 

Figure 6-1. Input Data of the Example Case 



Use of these data will generate the example results presented in this manual. The HYDTEST data 

are for illustration only and should not be taken as preferred values. 

Start HY DMOD3 using the methods described in Section 3.3. 

In the following sections, the procedure will be negotiated step by step. 

6.3 INPUT WINDOW 

Select "Open Project ..." from the File menu (in the INPUT Window). Retrieve the project file 

HYDTEST.HY3 in C:\HYDMOD3. After the user completes the dialog, the Main Window is displayed 

as shown in Figure 5-3. Other data input windows are shown in Figures 5-4,s-5,s-6, 5-7 and 5-11. 

Please refer to them. 

6.4 OUTPUT WINDOW AND PRINTOUTS 

Selecting 'Start" from the Bun menu in the INPUT Window will start the calculation. A message 

window will be displayed showing the progress of the calculation. 

The OUTPUT window and its child windows are shown in Figures 5-14 through 5-36. The figures 

displayed here are the printouts of corresponding windows. (For some test reports, only partial printouts 

are shown in order to save space.) 

6.4.1 

1. "Report" (Figure 6-2, continued on the following page) 



Hydraulics Analysis Report 

.................................................................... 
Flow rate (gpm) 420.0 
Pump output hydraulic power (HP) 562.03 
Circ. syetem HP loss(w/o bit) (HP) 392.34 
Bit hydraulic HP (HP) 169.68 
Wellhead pressure (psi) 2293.6 
Surface equipment press. loss (psi) 152.9 
Circ. system pressure loss (w/o bit) (psi) 1601.13 
Nozzle pressure loss (psi) 692.47 
Jet impact force (lbf) 690.13 
Impact force/hole area (psi) 6.82 
Nozzle area (in2) 0.55 
Nozzle velocity (ft/s) 243.98 .................................................................... 

Frictional Pressure Drop Inside the Drill Stringa, atc. 

- - - -  - - - - - - - - - 

Drill Press. Drop Flow Velocity 
Strings (psi) 5Pe ( ft/min) .................................................................... 
Surf ace 152.9 
Drill Stri 1004.01 
Drill Coll 288.87 
BHA 50 .0  

----------------- 
Bit Pressure Drop ----------------- .................................................................... 

Bit 692.47 T 14638.85 
- - - - ....................................... 

F'rictional Pressure Drop in the Annulus ....................................... .................................................................... 
1nner Outer P. Drop Plow Velocity 

(psi) Type ( ft/min) .................................................................... 
BHA 0.9 L 91.24 
Drill Coil 8.16 L 141.85 
Drill Coll 2.08 L 144.09 
Drill Stri 6.5 L 100.24 
Drill Stri Major Pay 5.96 L 100.24 
Drill Stri Shale Cap 0 .81  L 71.49 
Drill Stri 5.96 L 100.24 
Drill Stri Water Zone 2.31 L 107.23 
Drill Stri 8.13 L 100.24 
Drill Stri Depleted I 5.77 L 107.23 
Drill Stri 1.66 L 102.49 
Drill Stri Shale 0.44 L 78.43 
Drill Stri 10 .51  L 102.49 
Drill Stri Casing 46.17 L 107.23 

------------------ 
Hydraulics Details ------------------ .................................................................... 

No. M.D. TVD Press. ECD Velocity 



=--A=-===I End of Hydraulics Report ---=- 

Figure 6-2. Text Report of Hydraulics Analysis 

2. 'Pressurew (Figure 6-3) 

Total Pressure vs Measured Depth 
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Figure 6-3. Total Pressure Vs. Measured Depth 
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3. 'Frictional Pressure" Figure 6-4) 

Frictional Pressure vs Measured Depth 
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Figure 6-4. Frictional Pressure Vs. Measured Depth 

4. 'ECD" (Figure 6-5) 

MD. (ft) 

Wellbore ECD vs Measured Depth 
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/ JXD 

Figure 6-5. Wellbore ECD Vs. Measured Depth 



5. 'Velocity" (Figure 6-6) 

Velocity vs Measured Depth 
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Figure 6-6. Velocity Profiles 

6. 'Sensitivity" (Figures 6-7 and 6-8) 

A text report and one graph from this window are presented in Figures 6-7 and 6-8. 

S e ~ i t i v i t y  Analysis 

------------------------------------- 
Rato Head P 

# (mm) (ps i )  

- End of Senei t iv i ty  Analysis Report - 
Figure 6-7. Text Report of Sensitivity Analysis 



Wellhead Press.@si) vs. Flow Rate 
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Figure 6-8. Graph Output of Sensitivity Analysis 



6.4.2 

1.  'Reportw (Figure 6-9, which is a portion of the printout) 

Surge and Swab Report 

...................... 
Surge History Analysis 

Time 
(min) --------- 
0.0 
0.9 
1.8 
2.7 
3.6 
4.5 
5.4 
6.3 
7-2 
8.1 
9.0 
9.9 
10.8 
11.7 
12.6 
13.5 
14.4 
15.3 
16.2 
17.1 
18.0 
18.9 
19.8 
20.7 
21.6 
22.5 
23.4 
24.3 
25.2 
26.1 
27 0 
27.9 
28.8 
29.7 
30.6 
31.5 
32.4 
33.3 
34.2 
35.1 
36.0 
36.9 
37.8 
38.7 
39.6 
40.5 
41.4 
42.3 
43.2 
44.1 
45.0 
45.9 

Shoe P 
(psi) ------------- 
2559.61 
2560.47 
2562.58 
2564 85 
2567.12 
2569.39 

Shoe ECD 
(PHI .--------- 
13.0 
13.0 
13 -02 
13.03 
13.04 
13.05 
13.06 
13.07 
13.08 
13.08 
13.09 
13.09 
13.1 
13 1 
13 11 
13.11 
13 12 
13.12 
13.13 
13.13 
13.14 
13.14 
13 15 
13 15 
13 16 
13.17 
13.17 
13.18 
13.18 
13.19 
13.19 
13.2 
13.2 
13.21 
13 21 
13.22 
13.22 
13.23 
13 23 
13.24 
13.24 
13.25 
13.25 
13.26 
13.26 
13.27 
13.27 
13.26 
13.25 
13.25 
13.24 
13.23 

BE ECD 
(PHI ------ 
13.0 
13.0 
13.01 
13.02 
13.03 
13.04 
13.04 
13.05 
13.06 
13.06 
13.06 
13 07 
13.07 
13.07 
13 08 
13.08 
13.09 
13.09 
13.09 
13.1 
13.1 
13.1 
13 11 
13.11 
13.12 
13.12 
13.12 
13.13 
13.13 
13.14 
13.14 
13.14 
13.15 
13 15 
13 15 
13.16 
13.16 
13.17 
13.17 
13.17 
13.18 
13.18 
13.18 
13.19 
13.19 
13.2 
13.2 
13.2 
13.21 
13.21 
13.21 
13.22 





--------------------- 
Swab History Analysim ..................... --------------------------------------------------------------------- 

Time M.D. Qout Shoe P Shoe ECD BE P BHECD 
# (min) (ft) (gPm) (psi) (PN) (poi) (PB) 



End of Surge/Svab Report - 

Figure 6-9. Text Report of Surge and Swab (Closed-Pipe) 



2. 'Return Flow Rate" (Figure 6-10) 

Surge Return Rate vs Bit Depth 
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Figure 6-10. Surge Return Rate Vs. Bit Depth 

3. 'Casing Shoe Pressurew (Figure 6-1 1) 

Surge & Swab Effects on Shoe Pressure 
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Figure 6- 1 1. Surge and Swab Effects on Shoe Pressure 



4. "Casing Shoe E M '  (Figure 6-12) 

Figure 6-12. Surge and Swab Effects on Shoe EMW 
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5. "Bottom-hole Pressurew (Figure 6-13) 
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Figure 6-13. Surge and Swab Effects on Bottom-Hole Pressure 
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6. 'Bottom-Hole EMW" (Figure 6- 14) 

Figure 6-14. Surge and Swab Effects on Bottom-Hole EMW 

Surge & Swab Effects on Bottomhole EMW 
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6.4.3 

The only printout of this option is shown in Figure 6-15. 

I 

Cutting Waneport Report 

I '  I 

.............................. 
Valid For Vertical Section Only .............................. 

-10000 
/ F.1. 

Boltomhole EMW While Tripping @pg) 

Plow Rate (gpm)  : 
Weasured Depth (f t) : 
Tube Outer Diameter (in) : 
Hole Diameter (in) : 
Cutting Density (ppg) : 
Cutting Chip size(in) : 

Annular ~luid Velocity (f t/min) : 100.24 

Slip Velocity (Moore Corralation) (It/-in) : 18.06 
Cutting Traneport Ratio(1-Vsl/Va) (Woore) : 82. 

Slip Velocity (Chien Corralation)(ft/min): 30.12 
Cutting Transport Ratio (1-Vel/Va) (Chien) t 70.2 .......................................................... - End of Cutting Transport Report - 

Figure 6-15. Text Report of Cuttings Transport 

6-18 



6.4.4 . . 

1. 'Report" (Figure 6-16, which is a portion of the printout) 

Volumetric Displacemmt Report - 
....................................................................... 
Volume (bbl) Time (min) Strokes Required ....................................................................... 
Pipes: 124 -25 Pump from surface to bit: 12.42 1044 
Annulus: 856.51 Pump from bottom to surface: 85.65 7 195 
Total: 980.76 Pump one full circulation: 98.08- 8238 ....................................................................... 

....................... 
Volumetric Diaplacment ....................... ---------------------------..---------------------------------------------- 

Time Pump Pump P1. Pl. P1. P1.-2 P1.-3 F1.-4 F1.-5 
Stks Rate In Out Vol.In Ront Ront Ront Front 

# (min) (Qpm) (bbl) (it) (it) (ft) (f t) --------------------------------------------------------------------------- 
1 0.0 210.0 2 1 0.0 0.0 0.0 0.0 0.0 
2 0.99 42 210.0 2 1 4 . 9 6  347.95 0.0 0.0 0.0 
3 1.98 83 210.0 2 1 9.92 695.91 0.0 0.0 0.0 
4 2.97 125 210.0 2 1 14.88 1043.86 0.0 0.0 0.0 
5 3.97 167 210.0 2 1 19.83 1391.82 0.0 0.0 0.0 
6 4.96 208 210.0 2 1 24.79 ,1739.77 0.0 0.0 0.0 
7 5.95 250 210.0 2 1 29.75 2087.73 0.0 0.0 0.0 
8 6.94 292 210.0 2 1 34.71 2435.68 0.0 0.0 0.0 
9 7.93 333 210.0 2 1 39.67 2783.64 0.0 0-0 0.0 
10 8.93 375 210.0 2 1 44.63 3131.59 0.0 0.0 0.0 
11 9.92 417 210.0 2 1 49.58 3479.55 0.0 0.0 0.0 
12 10.91 458 210.0 2 1 54.54 3827.5 0.0 0.0 0.0 
13 11.9 500 210.0 2 1 59.5 4175.46 0.0 0.0 0.0 
14 12.89 541 210.0 2 1 64.46 4523.41 0.0 0.0 0.0 
15 13.88 583 210.0 2 1 69.42 4871.37 0.0 0.0 0.0 
16 14.88 625 210.0 2 1 74.38 5219.32 0.0 0.0 0.0 
17 15.87 666 210.0 2 1 79.33 5567.27 0.0 0.0 0.0 
18 16.86 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
19 17.85 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
20 18.84 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
21 19.83 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
22 20.83 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
23 21.82 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
24 22.81 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
25 23.8 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
26 24.79 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
27 25.78 672 0.0 2 1 80.0 5614.06 0.0 0.0 0.0 
28 26.77 725 340.0 3 1 86.27 6054.33 440.27 0.0 0.0 
29 27.77 792 340.0 3 1 94.3 6617.68 1003.62 0.0 0.0 
30 28.76 860 340.0 3 1 102.33 7181.04 1566.98 0.0 0.0 
31 29.75 927 340.0 3 1 110.36 7744.39 2130.33 0.0 0.0 
32 30.74 994 340.0 3 1 118.38 8307.75 2693.69 0.0 0.0 
33 3173 1062 340.0 3 1 126.41 -8980.243257.04 0.0 0.0 
34 32.72 1129 340.0 3 1 134.44 -8906.99 3820.4 0.0 0.0 
35 33.72 1197 340.0 3 1 142.47 -8797.01 4383.75 0.0 0.0 
36 34.71 1264 340.0 3 1 150.5 -8683.13 4947.11 0.0 0.0 
37 35.7 1332 340.0 3 1 158.52 -8569.26 5510.47 0.0 0.0 
38 36.69 1399 340.0 3 1 166.55 -8454.69 6073.82 0.0 0.0 
39 37.68 1466 340.0 3 1 174.58 -8357.57 6637.18 0.0 0.0 
40 38.67 1534 340.0 3 1 182.61 -8277.1 7200.53 0.0 0.0 





- End of Volumetric Displacement Report - 
- - - 

Figure 6-16. Text Report of Volumetric Displacement 

2. 'Volume In" (Figure 6-17) 

Figure 6-17. Fluid Volume Pumped in Vs. Time 
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3. "Fluid Fronts" (Figure 6-18) 

Figure 6-18. Fluid Fronts Vs. Time 
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6.4.5 Well 

1 .  "Report" (Figure 6- 19) 

Well Planning and Nozzle Selection Report 

Max. Jet Impact For- 

- - - - - - - - - - - -  - - - - - - -  - - - - - - - - - ------- ~ --- 

Meas. Opti. Opti. Opti. Opti. Bit Bit Impact PIHole S 
Depth Rate TPA Sys. P Bit P HP Vel . Force 

P (ft) ( W m )  (in21 (psi) (psi) (HP) (ftls) (lbf) (poi) ............................................................................. 
1 5000.0 694.81 0.514 1825.6 1597.4 647.54 433.48 1482.33 37.95 
2 6000.0 654.39 0.484 1825.6 1597.4 609.87 433.48 1396.09 21.87 
3 7000.0 619.97 0.459 1825.6 1597.4 577.8 433.48 1322.67 13.81 
4 8000.0 509.14 0.423 1825.6 1597.4 474.5 385.7 1220.8 9.56 
5 9000.0 458.69 0.397 1825.6 1597.4 427.49 370.56 1144.75 7.11 ............................................................................. 

Optimum Nozzle Selection Variance Analysis 

Assumed optimum Total Nozzle Area(in2) = 0.51 
- - -  - - - -  - - - - - - - - - - - - ....................................................... 

Two Area Five Area 
Noz . Vari. Noz. Vari . 
(1132in) (0) (1132in) (0) ....................................................... 
17.0+19.0 -2.2 11.0+11.0+12.0+12.0+12.0 1.4 
18.0+18.0 -2.5 11.0+11.0+11.0+12.0+12.0 -2.1 
19.0+19.0 8.6 11.0+12.0+12.0+12.0+12.0 4.8 

11.0+11.0+11.0+11.0+12.0 -5.6 
12.0+12.0+12.0+12.0+12.0 8.3 
10.0+10.0+11.0+12.0+12.0 -8.4 
10.0+11.0+11.0+11.0+12.0 -8.7 
11.0+11.0+11.0+11.0+11.0 -9.0 

Three Area Four 
Noz . Vari. Noz. 
(1132in) (0) (1132h) 

Area 
Vari . 
(0) 

-== End of Well Planning Report I 

,P'- 

Figure 6- 19. Text Report of Well Planning 



2. 'Optimum Flow Ratew (Figure 6-20) 

Optimum Flow Rate (gpm) vs Bit Depth(&) 
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Figure 6-20. Optimum Flow Rate Vs. Bit Depth 

3. 'Optimum Nozzle Areaw (Figure 6-21) 
r 
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Figure 4-21. Optimum Nozzle Area Vs. Bit Depth 
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4. 'Optimum Pressure" (Figure 6-22) 

Opthum Pressure Drop (psi) vs Bit Depth(ft) 
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Figure 6-22. Optimum Pressure Drop Vs. Bit Depth 

6.5 HYDMOD3 QUICK START 

Use the following procedure to rapidly start the HY DMOD3 program. 

Install: 

1. Start Windows (3.0 or later version). 

2. Insert Disk 1 in drive A:. 

3. In the File Manager, choose Run from the File menu. 

4. Type A:setup and press Enter. 

5. Follow on-screen instructions. (Please use the default subdirectory). 

Run: 

6. Double-click the HYDMOD3 icon. 

7. In the first window (Introductory Window), click 'OK" after it becomes responsive. 

8. In the INPUT Window, choose "Open Project.. ." from the File menu. 



9. From the 'Open HY3 Filew dialog box, click the drive C: in the drive list box, double-click 

the "HYDMOD3" subdirectory, click the 'HYDTEST.HY3" in the file list box, and then 

click OK. 

10. Click 'Nextw from the Page menu to view other pages of input data (WDI, SDI, FDI, HT3, 

HP3). 

11. Click the 'Startw from the Run menu. 

12. In the OUTPUT Window that follows, select the text report or graph windows of interest 

under the desired category to view the output. 

13. To print the text report or graph, make the corresponding child window active, select 'print 

report graphw from the File menu. 

14. Choose 'Return to Main Windoww from File menu to return to the Main Window or choose 

"Exitw to terminate the application. 
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8. Bug Report or Enhancement Suggestion Form 

Name: Company: 

Address: City: State: 

Phone No. : Fax No.: 

E-Mail: Date: 

BugProblem Report Enhancement Suggestion 

- - - - - - - - - -- 

Program Name and Version Number: 

BugProblem Description or Enhancement Suggestion: 

Other Comments: 

Will be mailed on diskette Will be faxed Attached None 

MS-DOS Version No.: MS-Windows Version No. : (Win 3.1NVin 95) 
OS2 MS-Windows NT Version No. : 

Other 

Please mail, fax, or e-mail to: 

Lee Chu 
MAURER E N G I I V ~ ~ N G  INC. 

2916 West T.C. Jester 
Houston, TX 770187098 

Ph: 7131683-8227 Fax: 7131683-6418 
&Mail: mei@maureng.com 
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Appendix A 
Common Conversion Factors in HYDMOD3 

PROPERTY 

Depth 

Hole Diameter 

Nozzle Size 

Flow Rate 

Fluid Velocity 

Nozzle Velocity 

Mud Weight 

L 
Viscosity 

Yield Point 

Power Law Constant K 

Pressure 

Force 

~ w e r  - 

TRAD~ONAL 
UNIT (ENGLISH) 

ft 

in. 

1/32 in. 

a m  

Wmin 

Wsec 

PPg 

CP 

lbfI100 ft2 

lbf.sn/ft2 

psi 

lbf 

HHP 

OTHER UNITS 

m 

mm 

nun 

m3/min 

literlmin 

barrel/ min 

elmin 

(Imp) gpm 
dmin  

d s e c  

kg/m3 

Spec gravity 

kPdm 

psi/100 ft  

lb/$ 

lbf-s/f? 

dyne-s/cm2 

Pa 

dyne/cm2 

Pa-sn 

dyne-sn/cm2 

eq CP 
kPa 

atm 

Bars 

kg/cm2 

N 

daN 

toMes 

kg 
HKW 

Cow.  
FACTOR 

0.3048 

25.4 

0.79 

0.003785 

3.785 

0.0238 

0.1337 

0.833 

0.3048 

0.3048 

119.83 

0.11983 

1.1756 

5.197 

7.481 

2.088 x 

0.01 

0.479 

4.79 

47.9 

479 

47900 

6.895 

0.06804 

0.06895 

0.0703 

4.448 

0.4448 

0.0004536 

0.4536 

0.7457 

EXAMPLE 

10,000 ft  = 3048 m 

12-114 in. = 31 1 ram 

10132 in. = 7.9 mm 

357 gpm = 1.35 m3/min 

357 gpm = 1351 lpm 

357 gpm = 8.5 bpm 

357 gpm = 47.7 ft?/min 

357 gpm = 297 (Imp) gpm 

100 Wmin = 30.48 d m i n  

300 Wsec 91.44 mlsec 

10 ppg = 1198.3 kg/m3 

10 ppg = 1.1983 S.G. 

10 ppg = 11.756 kPdm 

10 ppg = 51.97 psi/lOOft 

10 ppg = 74.81 lb/@ 

30 cp = 6.26 x 1@ lbf-s/f? 

30 cp = 0.3 dyne-s/cm2 

15 lbfI100 ft? = 7.2 Pa 

15 lbUl00 ft? = 71.9 dyne/cm2 

0.002 lbf-sn/ft = 0.0958 Pa-s" 

0.002 lbf-sn/ft? = 0.958 dyne-s"/cm2 

0.002 lbf-sn/ft? = 95.8 eq cp 

4000 psi = 27,580 kPa 

4000 psi = 272.2 atm 

4000 psi = 275.8 Bars 

4000 psi = 281.2 kg/cm2 

600 lbf = 2669 N 

600 lbf = 266.9 daN 

600 lbf = 0.272 tomes 

600 lbf = 272. kg 

400 HHP = 298.3 HKW 
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Appendix B 

HYDMOD3 Questionnaire 

Name: Company: 

Address: Fax No.: 

This is Version 3.0 of the HYDMOD program. We would appreciate your input and suggestions on this 
program. 

1. Have you had any problems installing and running HYDMOD3? 

2. What do you like best about the program? 

- - - - - -- - - - 

3. What do you like least about the program? 

4. How do you like the input format? 

5. How do you like the graphics presentation? 

6. Is it important for you to have a program listing that you can modify? Yes - No - 

7. How can we improve the program? 

Send To: Lee Chu 
MAURER ENGINEERING INC. 

29 16 West T.C. Jester 
Houston, Texas 770 18-7098 

PH: 7 13/683-8227 FAX: 713/683-6418 
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Appendix C 
International Keyboard 

All DEA computer programs developed at Maurer Engineering Inc. are written using the 'U.S." 

Keyboard. Under this keyboard, the '1000 separatof is a comma, and the 'decimal separator" is a period. 

Thus, the number one thousand, two hundred and thirty-four and twenty-twd100 is written 

1,234.22 
Numbers input into the programs are filed in this fonnat. 

Problem have occurred for some of our Participants who use the "Intemational Keyboard," as is common 

in Europe and South America. Here, the same number would be written 

1.234,22 
Here, the '1000 separatof is a period, and the decimal separator is a comma. 

European and South A m e W  users find that their computers garble input data being loaded into our DEA 

programs. 

This problem can be read@ solved by changing the Wiuduws "numbers format" from the Intemational to 

the U.S. format. This is accomplished as follows: 

1. From the DOS prompt, type 

WIN <ENTER> 

to open WINDOWS. 

2. From the Menu bar, choose Wiowweither by clicking on Window" or keying in 

<ALT> W 

This brings down the 'Select Window" menu screen, as shown in Figure C-1. 

Figure C- 1. Windows Menu Bar 



3. Select "Main" by clicking on 'Main" and then clicking on the 'OK" button. This brings down the 

'Main" menu screen as shown in Figure C-2. 

Prmpt - 
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Figure C-2. Main Menu Screen 

4. Select the "Contrd Panel" icon from the 'Main" menu screen. This is done by pointing the mouse 

to this icon and double clicking. This brings up the 'Control Panelw menu scxeen, as shown in 
Figure C-3. 

- - - p- - - 

Figure C-3. Control ~ a & l  Menu Screen 



5. Select the "International" icon from this menu screen by pointing to it with the mouse and double 

clicking. This brings up the 'International" Menu screen, as shown in Figure C-4. 

Figure C-4. International Menu Screen 

6. In the lawer right hand corner of the %temationaln menu screen is the 'Number Format." If the 

number under the words 'Number Format" is 

The DEA programs will run. Click on the 'Cancel" button in the upper right of this screen and 

back out to the 1Windows"menu screen to IUU your program. 

If the number under the words 'Number Formatw is 

1.234,22 

it must be changed before a DEA program will run successllly. 



7. To change 'Number Format," click on the 'Changen button in the 'Number Format" box on the 

screen. This will bring up the "International - Number Formatn screen. The '1000 Separatof box 
will be highlighted, as shown in Figure C-5. Key in 

This will erase the period from the '1000 separatof box and replace it with a comma. 

Figure C-5. International - Number Format Screen 

8. Either point the mouse to the box labeled uDecimal Separator" and click, or key in 

<TAB > 

This will highlight the 'Decimal !%?paratof box. 

9. Key in 

<DEL> . 

This will erase the comma from the box and replace it with a period. 



10. Either key in 

< ENTER > 

or point the mause to the "0K"button in the "International - Number Formatw box and click. This 

will return you to the 'International" menu screen, as shown in Figure Cd. 

Figure C 4 .  International Menu Screen, with Correct Number Format 




